The Constitution of India

Chapter IV A

Fundamental Duties

ARTICLE 51A

Fundamental Duties- It shall be the duty of every citizen of India–

(a) to abide by the Constitution and respect its ideals and institutions, the National Flag and the National Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render national service when called upon to do so;

(e) to promote harmony and the spirit of common brotherhood amongst all the people of India transcending religious, linguistic and regional or sectional diversities, to renounce practices derogatory to the dignity of women;

(f) to value and preserve the rich heritage of our composite culture;

(g) to protect and improve the natural environment including forests, lakes, rivers and wild life and to have compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective activity so that the nation constantly rises to higher levels of endeavour and achievement;

(k) who is a parent or guardian to provide opportunities for education to his child or, as the case may be, ward between the age of six and fourteen years.

Practical Notebook for Standard XI

Practical Notebook Cum Journal

Price: ₹ 63.00

Price: ₹ 59.00

Price: ₹ 74.00

- Based on Government approved syllabus and textbook
- Inclusion of all practicals as per Evaluation scheme.
- Inclusion of various activities and objective questions
- Inclusion of useful questions for oral examination
- Separate space for writing answers

E-learning material (Audio-Visual) for Standards One to Twelve is available through Textbook Bureau, Balbharati...

- Register your demand by scanning the Q.R. Code given alongside.
- Register your demand for E-learning material by using Google play store and downloading ebalbharati app.

www.ebalbharati.in, www.balbharati.in

E-learning material (Audio-Visual) for Standards One to Twelve is available through Textbook Bureau, Balbharati...
The Coordination Committee formed by GR No. Abhyas - 2116/(Pra.Kra.43/16) SD - 4 Dated 25.4.2016 has given approval to prescribe this textbook in its meeting held on 20.6.2019 and it has been decided to implement it from academic year 2019-20.

INFORMATION TECHNOLOGY

STANDARD ELEVEN

(Art, Commerce and Science)

Maharashtra State Bureau of Textbook Production and Curriculum Research, Pune.

Download DIKSHA App on your smartphone. If you scan the Q.R. Code on this page of your textbook, you will be able to access full text. If you scan the Q.R. Code provided, you will be able to access audio-visual study material relevant to each lesson, provided as teaching and learning aids.
The Constitution of India

Preamble

WE, THE PEOPLE OF INDIA, having solemnly resolved to constitute India into a SOVEREIGN SOCIALIST SECULAR DEMOCRATIC REPUBLIC and to secure to all its citizens:

JUSTICE, social, economic and political;
LIBERTY of thought, expression, belief, faith and worship;
EQUALITY of status and of opportunity;
and to promote among them all FRATERNITY assuring the dignity of the individual and the unity and integrity of the Nation;

IN OUR CONSTITUENT ASSEMBLY this twenty-sixth day of November, 1949, do HEREBY ADOPT, ENACT AND GIVE TO OURSELVES THIS CONSTITUTION.
NATIONAL ANTHEM

Jana-gana-mana-adhināyaka jaya hē
   Bhārata-bhāgya-vidhātā,

Panjāba-Sindhu-Gujarāta-Marāthā
   Drāvida-Utkala-Banga

Vindhya-Himāchala-Yamunā-Gangā
   uchchala-jaladhi-taranga

Tava subha nāmē jāgē, tava subha āsisa māgē,
   gāhē tava jaya-gāthā,

Jana-gana-mangala-dāyaka jaya hē
   Bhārata-bhāgya-vidhātā,

Jaya hē, Jaya hē, Jaya hē,
   Jaya jaya jaya, jaya hē.

PLEDGE

India is my country. All Indians are my brothers and sisters.

I love my country, and I am proud of its rich and varied heritage. I shall always strive to be worthy of it.

I shall give my parents, teachers and all elders respect, and treat everyone with courtesy.

To my country and my people, I pledge my devotion. In their well-being and prosperity alone lies my happiness.
Dear Students,

First of all Congratulations for completing your school education and welcome into the world of 10+2, which is often called as Junior College or Higher Secondary Education. Now you have stepped into the new horizon of education which is waiting for you. In these golden years of education, you are being exposed to many new technologies and skills. The skills, which you will acquire in these two years, are definitely going to help you throughout your life.

You all are blessed as you are born in this new era of technology and digital world where the word “Impossible” made it “I-m-possible” where I stand for Internet. Use of Information and communication Technology made your life pleasant and comfortable.

It is often seen that to handle the technology is quite easy but nobody is bothered to identify the know-how and pros and cons of the same.

In this book you will venture into the new technologies of Information Technology. The book is a combination of theoretical as well as practical skills. The Skill Oriented Practical (SOP) will give you a peek into the world of digital technology. You will certainly master a specific skill set which will help you further to enhance your higher education or job opportunities.

In this book new techniques of learning by doing are incorporated such as ‘quizzes’, ‘do it yourself’, ‘activity sheets’ which will promote thought provoking skills within you. The different activity sections in the textbook will definitely improve your logical, analytical and creative skills. You will learn about the emerging technologies of the digital world, which is the need of the era.

This book will surely create interest in the field of Information Technology due to its colourful presentation and enriching content. You will definitely appreciate and learn the contents with interest and enthusiasm through Q.R. Code.

Please do inform us what part of this book you found useful or difficult to understand.

We wish you the best in your future academic life.

(Pune)
Date : 20 June 2019
Indian Solar Year : 30 Jyeshtha 1941

(Dr. Sunil Magar)
Director
Maharashtra State Bureau of Texbook Production and Curriculum Research, Pune
Dear Teacher,

In this world of globalisation, Information Technology is a mature part of curriculum and has become a daily bread of Life. Technology changes with time, but concepts of handling data and converting data into information are constant and it is reflected in the terminology of Information Technology.

We present this book which is a combination of Computer basics, concepts, ideas and skill oriented practicals (SOP) in view of Digital India.

This duplet is entrusted upon you to bring about advanced computer literacy in our students. This combination of Theory and skill Oriented Practical’s (SOP) will make a remarkable computer based revolution in the knowledge of students. This book will achieve our objective of career developing and enhancing the skills as well as immediate employment in future. This book is designed with eye catching images in order to appeal the students to learn with interest and enthusiasm. The book has different activities to develop the students skills, and give him opportunity to explore different computer related aspects based on different topics. ‘Case studies’, ‘Quizzes’, ‘Do it yourself’, ‘Test your skills’ these small sections will definitely add a third dimensional thinking skills within the students. The book has been designed in such a way that the contents will be useful to the students from any stream in junior college whether Arts, Commerce or Science.

Dear Teachers, the Skill Oriented Practical (SOP) has six topics. You can select any four skills or practicals for your students based on his subject of choice and liking. It is recommended that teachers should conduct one practical based on stream (Science - Client Side Scripting (JavaScript), Commerce - Accounting Packages and Arts - Digital Content Creation).

This book will definitely create job opportunities like Jr. web designers, Jr. Account Assistant, Jr. Multimedia Designers/editors etc. at this 10+2 level. It will boosts his further career prospects be it in engineering CS, BCS BCA, B.Pharm CA, ICWA and even creative field like advertisements. The books gives hands on experience to the students and will definitely create confidence to handle the digital equipments. The Students will imbibe digital competency with your guidance and efforts. The ‘Cyber law’ topic will make our youngsters ethical users of digital media and create social awareness. The contents will help learners to develop ideas, find things out, make things happen, exchange and share information. We are confident that enthusiastic teachers and creative teachers like you will welcome the book.

This book has potential to create awareness about open source softwares. The book has adopted FOSS policy as per the Government of India regulation. This will definitely take our students towards Digital India Program.

Information Technology
Subject Committee and Study Group
Textbook Bureau, Pune
<table>
<thead>
<tr>
<th>Competency Statements For Information Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard - XI</td>
</tr>
</tbody>
</table>

### Competency

<table>
<thead>
<tr>
<th>Theory</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Key Concepts to create basic understanding about IT Enabled Technologies.</td>
</tr>
<tr>
<td>2. To acquire technical know-how about different types of software.</td>
</tr>
<tr>
<td>3. To acquire knowledge about 'Open source software'</td>
</tr>
<tr>
<td>4. To get knowledge about LINUX Commands.</td>
</tr>
<tr>
<td>5. To make the students aware about database concepts.</td>
</tr>
<tr>
<td>6. To introduce students to different terminologies used in database management systems.</td>
</tr>
<tr>
<td>7. To develop logical, problem solving, analytical and cognitive skills.</td>
</tr>
<tr>
<td>8. To acquire knowledge about webpage development.</td>
</tr>
<tr>
<td>9. To get technical knowledge to create dynamic web pages.</td>
</tr>
<tr>
<td>10. To make student socially aware while using internet / computer.</td>
</tr>
<tr>
<td>11. To create awareness about ethical ways of dealing with cyber world.</td>
</tr>
<tr>
<td>12. To develop problem solving skills using case studies, programs, activities etc.</td>
</tr>
</tbody>
</table>

### Skill Oriented Practicals (SOP)

<table>
<thead>
<tr>
<th>Skill Oriented Practicals (SOP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. To develop ability to use workplace productivity tool.</td>
</tr>
<tr>
<td>2. To develop ability to create presentations, handle documentation, easy way of calculation or computation.</td>
</tr>
<tr>
<td>3. To acquire web development skills.</td>
</tr>
<tr>
<td>4. To collect user data with the help of 'Form' feature.</td>
</tr>
<tr>
<td>5. To create dynamic web pages with the help of scripting language.</td>
</tr>
<tr>
<td>6. To develop logical skill by using different structures.</td>
</tr>
<tr>
<td>7. To acquire knowledge about Built-in-Functions in scripting language.</td>
</tr>
<tr>
<td>8. To introduce skill sets regarding use of computerized accounting.</td>
</tr>
<tr>
<td>9. To maintain &amp; display ledger accounts using accounting software.</td>
</tr>
<tr>
<td>10. To create &amp; edit image by using different tools.</td>
</tr>
<tr>
<td>11. To develop raster and vector images using image manipulation tools.</td>
</tr>
<tr>
<td>12. To enhance the creative ability by developing digital contents.</td>
</tr>
<tr>
<td>13. To acquire basic knowledge to use database commands.</td>
</tr>
<tr>
<td>14. To create &amp; maintain tables in a database.</td>
</tr>
<tr>
<td>15. To acquire knowledge to Insert, update &amp; delete data in tables.</td>
</tr>
<tr>
<td>16. Use of computing skills for career opportunities.</td>
</tr>
</tbody>
</table>
It is recommended that teachers should conduct one practical based on stream (Science - Client Side Scripting (JavaScript), Commerce - Accounting Packages and Arts - Digital Content Creation).
1 Basics of Information Technology

Let us Learn

- Definition of IT and ICT
- To understand concepts like data and information.
- Various concepts used under IT
- Different types of Operating Systems with its features and uses
- Architecture of Computer System
- Units of Memory
- Concepts related to Internet and Network with its types
- Recent trends, IT Enabled Services and careers in IT

1.1 An introduction to IT (Information Technology)

Information Technology has great influence on all aspects of life. Almost all work places and living environments are being computerized and the use of Information Technology is being enhanced.

**Definition of Information Technology:**

“IT (Information Technology) encompasses all of the technologies that we use in order to create, collect, process, protect and store information. It refers to hardware, software (computer programs), and computer networks”.

ICT (Information and Communication Technology) concept involves transfer and use of all kinds of information. ICT is the foundation of economy and a driving force of social changes in the 21st century. Distance is no longer an issue when it comes to accessing information; for example, work-from-home, distance learning, e-banking, and e-governance are now possible from any place with an internet connection and a computing device. Let’s first perceive two important concepts - Data and Information:

1.2 Data and Information

It is being said that the terms "data" and "information" are interchangeable and mean the same thing. However, they are not same and there is a difference between the two words. Data can be any character, text, word, number or raw facts. However, Information is data formatted in a manner that allows it to be utilized by human beings in some significant way. In the above example, the data appears to be a set of random words and numbers. However, when that data is interpreted, organized and formatted, one can tell that it is contact information of a person named as XYZ.

**Example of Data:**
Umbar, 1234, Xyz, MG Road, Calcutta, 9111111111, 84084

**Example of Information:**
Xyz, 1234, MG Road, Umbar 84084, Calcutta, 9111111111
**Need of information:** Information is required to take short term and long term decisions and also to make strategic decisions in an organization. Since we live in the “Information age”, Information Technology has become a part of our everyday life.

### 1.3 Various concepts used under IT

Before getting started let us learn some of the important concepts used under Information Technology:

#### 1.3.1 Computer:
The word Computer is derived from a Latin word “computare” which means to “to calculate”, “to count”, “to sum up” or “to think together”. An electronic device which accepts input from the user, processes it according to the instructions given to it and gives the required result in the form of output, is a computer.

**Computer System:**
A computer can process data, images, audio, video and graphics. A computer performs five major computer operations or functions irrespective of their size and make. These are -

1. It accepts data or instructions by way of input.
2. It stores data.
3. It can process data as required by the user.
4. It gives results in the form of output.
5. It controls all operations inside a computer.

#### 1.3.2 Architecture of Computer:
Computer Architecture is a specification detailing of how a set of software and hardware technology standards interact to form a computer system. In short, computer architecture refers to how a computer system is designed and how it works.

---

**Fig: 1 Computer System and Peripherals**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>An output device that lets you see your work as you go.</td>
</tr>
<tr>
<td>CD/DVD/Drive</td>
<td>Reads CD/DVD discs.</td>
</tr>
<tr>
<td>System Unit</td>
<td>The case that contains the CPU, memory, the power supply, disk drives, and all other hardware-such as a modem that are in an internal format.</td>
</tr>
<tr>
<td>Printer</td>
<td>Produces printed copies of computer output.</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>Located inside the system unit and used to store programs and data.</td>
</tr>
<tr>
<td>USB Port</td>
<td></td>
</tr>
<tr>
<td>Flash Memory Card Reader</td>
<td>Used to read flash memory card.</td>
</tr>
<tr>
<td>Web Camera</td>
<td>Used to capture either still picture or motion video.</td>
</tr>
<tr>
<td>Mouse</td>
<td>A pointing device used to make on-screen selections.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>The principal input device; used to type instructions into the computer.</td>
</tr>
<tr>
<td>Microphone</td>
<td>Used to get spoken input.</td>
</tr>
<tr>
<td>Speakers</td>
<td>Used to produce audio output.</td>
</tr>
<tr>
<td>CD/DVD Discs</td>
<td>Commonly used to deliver programs and store large multimedia files.</td>
</tr>
</tbody>
</table>
Every computer system has the following three basic components:

1. **Input Unit**
2. **Central Processing Unit**
3. **Output Unit**

**1. Input Unit**: This unit helps users to enter data and commands into a computer system. Data can be in the form of numbers, words, actions, commands, etc. The main function of input devices is to direct commands and data into computer. Computer then uses its CPU to process data and produce output.

   For example, a keyboard is an input device that enters numbers and characters. Similarly, even a mouse can be an input device for entering directions and commands. Other examples include barcode reader, Magnetic Ink Character Recognition (MICR), Optical Character Recognition (OCR), etc.

   Another example of input devices is touch-screens. Users can simply touch these screens without using any other device to enter commands. From smartphones to ATM machines, these input devices are becoming very popular nowadays.

**2. Central Processing Unit (CPU)**: After receiving data and commands from users, a computer system has to process it according to the instructions provided. Here, it has to rely on a component called the Central Processing Unit. The CPU further uses these three elements:

   a) **Arithmetic and Logic Unit**: This part of the CPU performs arithmetic operations. It does basic mathematical calculations like addition, subtraction, division, multiplication, etc. Further, it can
even perform logical functions like the comparison of data.

Primary Memory holds the data and instruction on which computer is currently working.

**Types of Primary Memory- Primary memory is generally of two types.**

1. **RAM**  
2. **ROM**

1. **RAM (Random Access Memory)**: It stands for Random Access Memory. RAM is known as read/write memory. It is generally referred to as main memory of the computer system. It is a temporary memory. The information stored in this memory is lost as the power supply to the computer is switched off. That’s why RAM is also called as “Volatile Memory”.

2. **ROM (Read Only Memory)**: It stands for Read Only Memory. ROM is a Permanent Type memory. The content is not lost when power supply is switched off. Content of ROM is decided by the computer manufacturer and permanently stored at the time of manufacturing. ROM cannot be overwritten by the computer. It is also called “Non-Volatile Memory”.

2) **Secondary Memory**: It is an external memory of the computer. It is used to store the huge amount of different programs and information.

The secondary storage devices are:

1. Magnetic (Hard) Disk
2. Magnetic Tapes
3. Pen Drive
4. Flash memory
5. Optical Disk (CD,DVD)
6. SSD etc.

**b) Control Unit**: This unit is the backbone of computers. It is responsible for coordinating tasks between all components of a computer system. The control unit collects data from input units and sends it to processing units depending on its nature. Finally, it further transmits processed data to output units to facilitate users.

**c) Memory Unit**: Once a user enters data using input devices, the computer system stores this data in its memory unit. This data will now remain here until other components of CPU process it. The memory unit uses a set of pre-programmed instructions to further transmit this data to other parts of the CPU.

**Types of Memory- There are two types of memory**

1) Primary Memory  
2) Secondary Memory

1) **Primary Memory**: Primary memory is internal memory of the computer. It is also known as main memory.
3. Output Unit: The third and final component of a computer system is the output unit. After processing of data, it is converted into a format which human can understand. After conversion, the output unit displays this data to users. Examples of output devices include monitors, screens, printers and speakers etc. Thus, output units basically reproduce the data formatted by the computer for user's benefit.

Do it yourself

Try to find out names of the modern input devices used in shops/malls.

1.3.3 Units of Memory: Computer storage and memory is often measured in Megabytes (MB) and Gigabytes (GB). Let us understand the evolution of memory.

Bit: It is a binary digit that holds only one of two values: 0 or 1.

Nibble: A group of 4 bits is called a nibble (For example: 1011, 1001, 1111).

Byte: A group of 8 bits is called a byte. A byte is the smallest unit, which can represent a data item or a character. (For example: 11101100, 10000001)

<table>
<thead>
<tr>
<th>Different Units of Memory</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>Single Binary Digit (1 or 0)</td>
</tr>
<tr>
<td>1 Byte</td>
<td>8 Bits</td>
</tr>
<tr>
<td>1 KiloByte (KB)</td>
<td>1,024 Bytes</td>
</tr>
<tr>
<td>1 MegaByte (MB)</td>
<td>1,024 KiloBytes</td>
</tr>
<tr>
<td>1 GigaByte (GB)</td>
<td>1,024 MegaBytes</td>
</tr>
<tr>
<td>1 TeraByte (TB)</td>
<td>1,024 GigaBytes</td>
</tr>
<tr>
<td>1 PetaByte (PB)</td>
<td>1,024 TeraBytes</td>
</tr>
<tr>
<td>1 ExaByte (EB)</td>
<td>1,024 PetaBytes</td>
</tr>
</tbody>
</table>

Table: 1 Different Units of Memory

1.3.4 Concept of Hardware and Software:

Hardware: Computer hardware comprises of the physical components that a computer system requires to function. In simple words, hardware are the parts which we can see, we can touch them, feel them. It encompasses everything with a circuit board that operates within a Personal Computer or Laptop; including the motherboard, graphics card, CPU (Central Processing Unit), ventilation fans, webcam, power supply, and so on.

Software: A set of instructions given to the computer is known as a program. Program or set of programs are called as software. This helps us to interact with the computer in order to perform a particular task. Software is a generic term used to describe computer programs.

1.3.5 Categories of a software:

Open source software: It refers to the software which releases code in public domain for anyone to use. The source code can be copied, modified or distributed by other users and organizations. As the software is open to the public, the result is that it constantly updates, improves and expands as more people can work on its improvement. Many states are following FOSS policy i.e. Free Open Source Software Policy and it enabled them to save some million of rupees each year in licensing costs. The Kerala state is in news as they have adopted FOSS policy and saved rupees 300 crore as a license fee for proprietary or closed source software.
Closed source software: It is opposite to Open Source Software and means that the software is used by the proprietary and has a closely guarded code. Only the original authors of organization of a software can access, copy, and alter that software. In case of closed source software, user has to purchase the software before using it.

1.3.6 Computer software can be classified into two types based on its utility:

Application Software: Application software is a program or group of programs designed for end users. Applications software (also called end-user programs) include programs like database programs, word processors, web browsers, presentation software, spreadsheets etc.

System Software: System Software is a set of instructions required for a computer to work. For Example, Linux Operating system is a program that allows different applications and various components of hardware such as monitor, printer, mouse, keyboard etc. to communicate with each other.

- The operating system boots up the computer and makes sure that everything is operational.
- The operating system is also what runs the cell phone and most of the electronic devices.
- The operating systems usually come preloaded on any computer, tablet, laptop or cell phone that you buy.
- Most people use the operating system that comes with their device as default.
- It is necessary to use licensed operating system and not a copied or a pirated one.
- There are many open source operating systems available on the web which are freely downloadable. It is advisable to use those OS instead of pirated ones. *Refer Page 61(Software Piracy)

Let’s understand more about an operating system

- A computer would not be able to function correctly without an operating system.
- An operating system is a software program that empowers the computer hardware to communicate and operate with the computer software.

Do it yourself

- List out the open source and closed source software.

1.3.7 Operating Systems for Personal Computers:

DOS: DOS (Disk Operating System) was the dominant operating system for microcomputers in the 1980's and the early 1990's. For working with DOS the user needs to know how to input the commands using the Command Prompt Window.

Windows: Windows is a series of operating systems that are designed by Microsoft. The first two versions of the Windows operating system, introduced
in 1985 and 1987 respectively, were primitive. Windows is the most commonly used operating system.

**Mac OS** : Apple Corporation’s registered operating system is called Mac OS.

**Chrome OS** : Chrome OS is an open-source operating system created by Google to create a better computing experience for people who spend most of their time on the web.

**UNIX** : UNIX was trademarked in 1969 by a group of AT&T employees at Bell Labs as a multitasking, and multi-user computer operating system.

**Linux** : Linux is an open-source, portable, multi-user (multiple users can access system resources like memory/RAM/application programs at the same time), multiprogramming, operating system. It is very similar to other operating systems, such as Windows and a source code is available to the public.

1.3.8 Operating Systems for Mobile Phones:

There are many different operating systems for mobile phones and devices. These are Android, Asha, Blackberry, iOS, Windows Phone etc.

**Android** : Android is a free and open source operating system provided by Google. It is most popular OS amongst all other OS.

**Asha** : Asha is used by Nokia phones. This is closed source OS.

**Blackberry** : This is a closed source operating system for smartphone and tablet devices.

**iOS** : iOS is Apple's closed source operating system for Apple's iPhone, iPod Touch, iPad and second-generation Apple TVs.

**Windows Phone** : Windows Phone is developed by Microsoft as a closed source operating system for mobile phones.

1.4 Introduction to GNU/Linux (GNU Not Unix)

GNU/Linux is a family of operating systems that are created by various companies, organizations, and individuals. It is created by using Free Software Philosophies. This means that GNU/Linux operating systems are usually free of charge, free to distribute, and they are open source. Open Source is when a person can view and modify the code for a piece of software. This is important because by having the ability to look and audit the code, user can be sure that the program does not perform malicious tasks. It also allows the user to program their own features, or fix problems, and help the developers. This results in higher quality code and more secure programs. This is why GNU/Linux is used as the predominantly backbone of the Internet. Most websites that user visits run on GNU/Linux. In fact, as of 2018, all the world’s fastest 500 computers run Linux.

**Ubuntu** is one of the most popular GNU/Linux distribution.

There are two main ways to interact with the computer: The GUI (Graphical User Interface) and the CLI (Command Line Interface)
**Graphical User Interface (GUI)**

The graphical user interface is when the user interacts with the computer using images, icons, and dialog boxes. The Fig. no. 4 shows what the Ubuntu 18.04 looks like. This GUI is called GNOME. There are a lot of GUI's (Or desktop environment) that user can install, but this is the default.

The left bar is called the Panel. There are shortcuts to programs, as well as currently open programs. The top bar has the date and time. If it is clicked a menu will pop up with the calendar and notifications. Fig. no. 4 shows that the top right side will show user the battery information, if on a laptop, network information (such as WiFi, or Ethernet), and options for logging in, restarting, and shutting down the computer.

At the bottom left, there is an icon for the app menu. Clicking on it will show a list of all the apps installed on the computer. The search option is used for quick search of the application.

The home folder is where all the personal documents and settings are stored, and every user has their own home folder.

**Note:** Installing new software on Ubuntu is done using the 'Ubuntu Software' Center.

**Do it yourself**

- Open the Ubuntu Software Center from the panel.
- Search for GIMP (it is an image editing program) and install.
- Run updates and uninstall software from the software center.
- Log out, Log in, and Restart the computer.
Command Line Interface (CLI)

The command line interface is when user interacts with the computer using text. This is done by typing commands into a terminal. The default CLI on Ubuntu 18.04 is called 'bash'. It is a command processor that runs in a text window where the user types commands that causes actions. The commands are programs that are run when user types command name. There are number of different commands that user can use. Some are explained in Table no. 2.

Do it yourself

- Open Firefox browser from the command line.
- Create a new file on the Desktop called hello.txt.
- Change directory to Desktop using 'cd' command.
- Open hello.txt in Nano text editor.
- Write a message in hello.txt and save it.
- Print the contents of hello.txt with 'cat' command.
<table>
<thead>
<tr>
<th>Command</th>
<th>Short Description</th>
<th>Usage example</th>
<th>Detailed description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ls</strong></td>
<td>List Directories</td>
<td><code>ls</code></td>
<td>[List Directories] Prints the list of directories in the current one.</td>
</tr>
<tr>
<td><strong>pwd</strong></td>
<td>Print Working Directory</td>
<td><code>pwd</code></td>
<td>[Print Working Directory] Prints the path to the current directory.</td>
</tr>
<tr>
<td><strong>whoami</strong></td>
<td>Who Am I?</td>
<td><code>whoami</code></td>
<td>[Who Am I?] Prints the name of the current user on terminal.</td>
</tr>
<tr>
<td><strong>lscpu</strong></td>
<td>List CPU</td>
<td><code>lscpu</code></td>
<td>[List CPU] Prints information about your CPU on terminal.</td>
</tr>
<tr>
<td><strong>touch</strong></td>
<td>Touch</td>
<td><code>touch filename.txt</code></td>
<td>[Touch] Creates a new file.</td>
</tr>
<tr>
<td><strong>cd</strong></td>
<td>Change Directory</td>
<td><code>cd Downloads</code></td>
<td>[Change Directory] Control goes to a different directory.</td>
</tr>
<tr>
<td><strong>nano</strong></td>
<td>Nano is a text editor</td>
<td><code>nano filename.txt</code></td>
<td>Nano is a text editor. This command will open the file FileName.txt (or create it if it doesn't exist). You can type text in Nano, and when you are done you can press Control + O followed by Enter to save and Control + X followed by Enter to exit Nano.</td>
</tr>
<tr>
<td><strong>cat</strong></td>
<td>Concatenate</td>
<td><code>cat file1.txt file2.txt</code></td>
<td>[Concatenate] Prints the contents of the files listed on the screen.</td>
</tr>
<tr>
<td><strong>Echo</strong></td>
<td>A built in command</td>
<td><code>echo --help</code></td>
<td>Used to display line of text or string that are passed as an argument.</td>
</tr>
<tr>
<td><strong>Clear</strong></td>
<td>To clear</td>
<td><code>clear</code></td>
<td>To clear the command prompt.</td>
</tr>
</tbody>
</table>

**Table: 2 Few Linux Commands**

**The GNU/Linux File System Hierarchy Standard**

In GNU/Linux, the topmost directory is called the root directory, and it is written as `/`. All directories are stored under the root directory. For example if the user is ABC, the home directory will be created at `/home/ABC`. Everything in Linux is represented as a file, this includes Cameras, Storage devices, Microphones, Network devices, etc.

This is a brief summary of the file system:

- `/` : The root directory. All files and directories are stored under this directory, including all hard drives, pen drives, CD-Drives, etc.
- `/bin` : Essential system programs are stored here.
- `/dev` : All connected devices are stored here. Including internal devices, temperature sensors, and batteries.
- `/etc` : System configuration files are stored here.
- `/proc` : Files that provide information about processes. This is information like, how much RAM is free, or how fast the CPUs are running.
- `/tmp` : Temporary files are stored here
- `/home` : Users home directories are stored here.

There are many more directories. The user can read more about them by
searching for "File System Hierarchy Standard (FHS)" online.

**Why Learn and Use GNU/Linux?**

There are huge number of benefits of learning GNU/Linux. Sooner or later in the career, GNU/Linux will be used in the workplace. Millions of desktops and servers run on GNU/Linux. The Android operating system, that the smartphone runs on, is a modified version of GNU/Linux.

1. **Linux is Free and Open Source:**
   The word “Free” here does not just mean free of charge but also means “Freedom”. Anyone is free to use this software, distribute them freely and even study and modify the source code to suit one's own need.

2. **Linux Operating System is free from viruses:** The user need not install any anti-virus software. This saves money as well as valuable time. The users are free from the trouble of updating the virus definitions and checking unknown USB disk that is plugged in. Moreover, anti-virus software is not hundred percent reliable. The user always runs the risk of losing the data if the computer is infected due to the failure of anti-virus software. Finally, anti-virus software often gives a false alarm and may delete the files assuming the existence of the virus.

3. **Easy to keep all the software up-to-date:** Proprietary operating systems can update themselves. But they cannot update other software, especially proprietary software. The user has to keep track of each application on his own. Linux distributions mostly use free software so it keeps track of all the softwares through repositories. Repositories is a collection of software for a Linux distribution on the server. The package manager updates the operating system as well as other softwares periodically.

4. **Linux is flexible and easily customizable:** The user can change the desktop, the position of the menus, status bar position, style, default file manager, icon theme and lot more. Almost everything in Linux is customized.

5. **Excellent Support:** There are thousands of forums and millions of people ready to help open source software users. Each distribution has its own community of users and they help each other. Many software companies and developers of free software also offer solutions to the problems through community platforms and also through professional channels.

1.5 **Computer Network**

1.5.1 **Introduction:** It is a group of interconnected computers or devices to have communication within themselves. A computer network consists of a collection of computers, printers and other equipment that is connected together so that they can communicate with each other.

1.5.2 **Types of networks:** There are three types of network based on the geographical area they cover: LAN, MAN and WAN.
The entire use and implementation of these types depends upon the geographical area they cover, i.e. LAN covers the smallest area; MAN covers an area larger than LAN and WAN comprises the largest of all.

Local Area Network (LAN):
- LAN covers smaller geographical area (Size is limited to a few kilometers) and are privately owned.
- Usage area is limited to areas such as an office building, home, hospital, schools, etc.
- It covers a short distance, and so the error and noise are minimized.
- LAN is easy to setup.
- Data transmits at a very fast rate as the number of computers linked are limited.
- It is a less expensive hardware and maintenance cost is also low.

Metropolitan Area Network (MAN):
- MAN is larger area than that of a LAN and smaller area as compared to WAN.
- It connects two or more separate computers that reside in the same or different cities.
- It covers a large geographical area and may serve as an ISP (Internet Service Provider).
- It is hard to design and maintain a Metropolitan Area Network.

Examples of a MAN are the part of the telephone company network that can provide a high-speed DSL line to the customer or the cable TV network in a city.

Wide Area Network (WAN):
- Wide Area Network is a computer network that extends over a large geographical area.
- It might be confined within the bounds of a state or country.
- A WAN could be a connection of LAN connecting to other LAN’s via telephone lines and radio waves.
- The technology is high speed and relatively expensive.
- A Communication medium used for WAN is Telephone Network or Satellite Link.
- Due to long distance transmission, the noise and error tends to be more in WAN.

1.6 Network Configurations:
Network architecture is the design of a computer network. It is a framework for the specification of a network's physical components and their functional organization and configuration.

Two of the most widely used types of network architecture are peer-to-peer and client/server.

1. Peer-to-Peer Architecture: In this type of architecture, all the machines, called as “peers”, have the same status and they can communicate with
any other peer directly. A Peer-to-Peer network has no dedicated servers. Its implementations are meant for small networks. For Example, when students creates a network to share files through Bluetooth or SHAREit, the mobile device forms peer-to-peer network for transfer of files.

2. **Client-Server Architecture**

   This type of architecture is most suitable for larger network. So there are two types of machines in network, client and server.

   **Client**: A computer which is seeking any resource from another computer is a client computer. For Example: Downloading an image file from a website, browsing Intranet/Internet etc. The network user normally uses a client computer to perform his day to day work.

   **Server**: If a computer has a resource which is served to another computer, it is a server computer. The client establishes a connection to a server and accesses the services installed on the server. A server is not meant for a network user to browse in internet or do spreadsheet work. For Example: Multimedia server, File storage servers, Webserver etc.

**Fig. : 7 Peer-to-Peer Architecture**

**Fig. : 8 Client-Server Architecture**

1.6.1 **Internet**

   Internet means connecting computer to any other computer anywhere in the world. Internet is the highway of information.

   The Internet has one very simple job: to move computerized information (known as data) from one place to another. The Internet is generally defined as a global network connecting millions of computers.

   The Internet is a massive network of networks, a networking infrastructure. With the help of the internet one can easily be in touch with any one in the whole world by sending electronic mail, by chatting. Travel bookings can be made very easily, one can order books or buy anything online. In simple terms it can be said that internet provides a very
strong connection or network between computers globally, bringing people and their working close to each other.

1.6.2 History of Internet:

The first workable prototype of the internet came in the late 1960's with the creation of ARPANET, or the Advanced Research Projects Agency Network. Originally funded by the U.S. Department of Defense, ARPANET used packet switching to allow multiple computers to communicate on a single network. The technology continued to grow in the 1970's after scientists Robert Kahn and Vinton Cerf developed Transmission Control Protocol and Internet Protocol, or TCP/IP, a communications model that set standards for how data could be transmitted between multiple networks. ARPANET adopted TCP/IP on January 1, 1983, and from there researchers began to assemble the “network of networks” that became the modern Internet. The online world then took on a more recognizable form in 1990, when computer scientist Tim Berners-Lee invented the World Wide Web (WWW).

1.6.3 Protocols:

A protocol is a set of rules that governs the communications between computers on a network. In order to have two computers to talk to each other, they must be speaking the same language.

Examples of Protocols are:

- **TCP/IP**: Transmission Control Protocol & Internet Protocol - It breaks down the message into packets and sends them out into the network.
- **DNS**: Domain Name System - It translates network address (such as IP addresses) into terms understood by humans (such as Domain Names) and vice-versa.
- **DHCP**: Dynamic Host Configuration Protocol - It can automatically assign internet addresses to computers and users.
- **FTP**: File Transfer Protocol - A protocol that is used to transfer and manipulate files on the internet.
- **HTTP**: HyperText Transfer Protocol - An internet-based protocol for sending and receiving web pages.
- **IMAP**: Internet Message Access Protocol - A protocol for receiving e-mail messages from server on the Internet. It maintains a copy of all the emails on server. We can sort, filter emails.
- **IRC**: Internet Relay Chat - A protocol used for Internet chat and other communications. It facilitates communication in the form of text.
- **POP3**: Post Office Protocol Version 3 - A protocol used for receiving e-mail from remote mail servers. It does not maintain copy on the server.
- **SMTP**: Simple Mail Transfer Protocol - A protocol for sending e-mail messages to the Server on the Internet.
1.7 IT Enabled Services

1.7.1 Meaning of IT Enabled Services:

IT Enabled Services (ITES), also called web enabled services or remote services or tele-working, covers the entire amount of operations which exploit Information Technology for improving efficiency of an organization. The most important aspect is the value addition of IT Enabled Service. The value addition could be in the form of Customer relationship management, improved database, improved look and feel, etc. The outcome of an IT Enabled Service is in two forms:

- Direct Improved Service.
- Indirect Benefits.

Whereas direct benefits can be realised immediately, indirect benefits can occur over a period of time, and can be harnessed very effectively, if planned well up front.

1.7.2 Popular IT Enabled Service centers:

Popular IT Enabled Service centers are -

- Call Centers
- Electronic Publishing
- Medical Transcription
- Data Centers
- GIS Mapping (Geographic Information System)
- ERP (Enterprise Resource Planning)
- Knowledge Management & archiving.

1.8 Careers in IT

Various career opportunities are available for IT professions. These vary from operator to Specialised skilled programmers. Some of the career opportunities are as follows:

1. Web Designer and Developer: One can develop interactive websites using knowledge of HTML, PHP and various other programming languages.

2. Software Developer: It is possible to have career as a software developer with the scripting skills.

3. Database Manager: After getting knowledge about Database management one can work as a Database Manager with the help of SQL skills.

4. Information Security Analyst: Information Security Analysts are responsible for ensuring that networks are watertight. They educate staff to avoid unintended disclosures and keep up to speed with potential external threats.

5. Professional Accountant: Using computerized accounting software one can successfully handle accounting work of any small or large scale organization.

6. Financial Advisor: After getting IT knowledge one can advise and guide others in investing the money in various investment schemes with their calculations and benefits in future.

7. Cyber Advisor: Anyone can develop his or her career as a cyber-advisor.
8. **Animator**: This is the most demanding career in today’s era. It is possible to become a successful animator using one's own creation and innovation with the help of software like GIMP, Inkscape etc.

9. **Games developer**: Perhaps one of the trendiest and most fun jobs in the sector, a games developer gets to work on titles for consoles, computers, smart phones, tablets and online. Creativity and imagination are important but the ability to work in a highly pressurised environment is also crucial.

10. **Audio / Video Editor**: As a career opportunity, to become an Audio / Video Editor, one should be good in tools such as Kdenlive, Audacity. With the help of these tools one can develop a career as a video journalist.

### 1.9 Recent trends in IT

1. **Green Computing**: It is the study and practice of environmentally sustainable computing or IT.

   The goals of green computing are similar to green chemistry:
   - To reduce the use of hazardous materials
   - To maximize energy efficiency during the product's lifetime
   - To recycle or biodegradation of non-functional products and factory waste.

   Green computing is important for all classes of systems, ranging from handheld systems to large-scale data centers.

2. **Internet of Things (IoT)**: The Internet of Things (IoT) is the network of physical devices, vehicles, home appliances, and other items embedded with electronics, software, sensors, actuators, and connectivity which enables these things to connect, collect and exchange data creating opportunities for more direct integration of the physical world into computer-based systems, resulting in efficiency improvements, economic benefits, and reduced human exertions.

3. **Cloud Computing**: It is the delivery of computing services - servers, storage, databases, networking, software, data analytics and more - over the internet.

4. **Data Analytics (DA)**: It is the process of examining data sets in order to draw conclusions about the information they contain, increasingly with the help of specialized systems and software. Data analytics technologies and techniques are widely used in commercial industries to enable organizations to make more-informed business decisions and by scientists and researchers to verify or disprove scientific models, theories and hypothesis.

5. **Artificial Intelligence (AI)**: It is intelligence demonstrated by machines, in contrast to the natural intelligence displayed by humans and other animals. Computer science defines AI research as the study of "intelligent agents": any device that perceives its environment and takes actions that maximize its chance of successfully achieving its goals.

6. **Machine Learning (ML)**: It is the scientific study of algorithms and statistical models that computer systems use to effectively perform a
specific task without using explicit instructions, relying on patterns and inference instead. It is seen as a subset of artificial intelligence.

7. **Big Data**: It refers to data sets that are too large or complex for traditional data-processing application software to adequately deal with. Data with many cases offer greater statistical power, while data with higher complexity may lead to a higher false discovery rate.

8. **Blockchain**: It is a growing list of records, called blocks, which are linked using cryptography. It can be defined as a distributed, decentralized, public ledger.

---

**Summary**

- Data can be any character, text, word, number or raw facts. Information is data formatted in a manner that allows it to be utilized by human beings in some significant way.
- IT (Information Technology) involves all of the technology that we use to collect, process, protect and store information.
- Computer architecture refers to how a computer system is designed and how it works.
- Computer hardware is the set of physical components that a computer system requires to function.
- Software is a set of instructions or programs instructing a computer to do specific tasks.
- Computer storage and memory is often measured in MegaBytes (MB) and GigaBytes (GB).
- Computer software can be classified into two types—Application Software and System Software.
- Open Source Software is a code free software available freely to copy and modify.
- Closed source Software is having proprietary rights with the developers and are paid ones.
- GNU/Linux operating systems are usually free of charge, free to distribute, and they are open source.
- There are two main ways to interact with the computer: GUI and CLI.
- Internet means connecting computer to any other computer anywhere in the world.
- A protocol is a set of rules that governs the communications between computers on a network.
- A computer network consists of a collection of computers, printers and other equipment that is connected together so that they can communicate with each other.
- LAN, MAN, WAN are types of network.
- Massive career opportunities are available for IT professionals.
Q.1 Complete the following activity

1) Tick the appropriate box

- Disk
- System

Q.2 Divide the following list of devices into appropriate categories.

(Monitor, Barcode reader, Printer, Keyboard, Optical character reader, Speaker)

<table>
<thead>
<tr>
<th>Categories</th>
<th>Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Devices</td>
<td></td>
</tr>
<tr>
<td>Output Devices</td>
<td></td>
</tr>
</tbody>
</table>

Q.3 Multiple choice two correct answers.

1) The primary memory consists of ................. and .................
   a) Pendrive b) Hard Disk c) RAM d) Scanner e) ROM

2) The network architectures which are widely used are .................
   a) Server b) Client c) Peer to peer d) Client-server e) Internet

Q.4 Match the following.

1) IS (a) change directory
2) FTP (b) Translates Network Address
3) CD (c) List of Directory
4) DNS (d) To transfer file on internet
Q. 5 Name the following and complete the diagram.

Q. 6 Complete the following with Linux commands with their use.

Q. 7 Complete the list of following protocols.

Q. 8 Complete the following Long form.

Q. 9 Identify the following activity.

You are typing a letter using a computer and suddenly there is a power failure.

Which type of Memory does this activity deal?

Q. 10 Answer the following

1) What is Data and Information? Give examples of data and information.
2) Explain functional units of a computer system.
3) What is a storage unit? Explain types of primary memory storage.
4) Explain how Linux is different from Windows.
5) Write down the difference between LAN, MAN and WAN.
2.1 Introduction

In our day to day life every person uses database in various ways. Like people use phone diary or phone book which contains name, address email id, phone number etc.

Doctor maintains medical history of patients. Librarian maintains records of their book details, issue date, return date etc. Teacher keeps records of students like name, roll number, Marks etc. In these examples every one maintains records in a systematic manner.

In a computer system, we always maintain our records. At this point a database is very useful.

2.2 Definition of a Database

Database is collection of interrelated data which helps in efficient retrieval, inserting and deleting of data. In exams, marks obtained by the student in subjects is data before it is entered in the report card. In a report card, the combined (marks) data of all subjects speaks about students performance. Thus when data is maintained in an organized manner it becomes meaningful or organized information.

<table>
<thead>
<tr>
<th>Data</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data is raw facts</td>
<td>Information is processed data</td>
</tr>
<tr>
<td>Data does not help in decision making</td>
<td>Information helps in decision making</td>
</tr>
<tr>
<td>Data could be relevant or irrelevant</td>
<td>Without data information cannot be processed</td>
</tr>
<tr>
<td>Each student's exam score is one piece of data.</td>
<td>The average score of a class or of the entire school is information that can be derived from the given data.</td>
</tr>
</tbody>
</table>

Table: 1 Data vs Information

Do it yourself

Collect five examples of data and information
2.3 Introduction to Database Management System (DBMS)

A database, often abbreviated as DB, is a collection of information organized in such a way that a computer program can quickly select desired pieces of data.

A Database Management System (DBMS) is a software for creating and managing databases. The DBMS provides users and programmers with a systematic way to create, retrieve, update and manage data. It stores data in such a way that it becomes easier to retrieve, manipulate, and update information.

Examples of popular DBMS are:
MySQL, PostgreSQL, Access, Oracle, SQL Server, IBM, DB2 and Sybase.

2.4 Some Applications of DBMS

- Railway Reservation System:
  Database is required to keep record of ticket booking, train’s departure and arrival status, status of seats available etc.

- Library Management System:
  There are thousands of books in the library so it is very difficult to keep a record of all the books in a copy or register. So DBMS is used to maintain all the information related to book issue dates, name of the book, author and availability of the book.

- Banking:
  People make thousands of transactions through banks daily and they can do this without going to the bank. So now banking has become so easy that by sitting at home bank customers can send or get money through banks. All this is possible just because of DBMS that manages all the bank transactions.

- Universities and Colleges:
  Examinations are done online today and universities and colleges maintain all these records through DBMS. Student’s registration details, results, courses and grades all the information is stored in a database.

- Credit Card Transactions:
  For purchase of credit cards and all the other transactions are made possible only by DBMS. A credit card holder knows the importance of his information that all are secured through DBMS.

- Social Media Sites:
  We all are on social media websites to share our views and connect with our friends. Daily, millions of users sign up for these social media accounts like Facebook, Twitter, Pinterest and Google plus. But how is all the information of users stored and how are we able to connect to other people? Yes, this is all because of DBMS.

2.5 Advantages of DBMS

- Reducing Data Redundancy:
  The file based data management systems contained multiple files that were stored in many different locations in a system or even across multiple systems. Because of this, there were sometimes multiple copies of the same file which lead to data redundancy.
This is prevented in a database as there is a single database and any change in it is reflected immediately. Because of this, there is no chance of encountering duplicate data.

- **Sharing of Data:**
  In a database, the users of the database can share the data among themselves. There are various levels of authorisation to access the data, and consequently the data can only be shared based on the correct authorisation protocols being followed.

  Many remote users can also access the database simultaneously and share the data between themselves.

- **Data Integrity:**
  Data integrity means that the data is accurate and consistent in the database. Data Integrity is very important as there are multiple databases in a DBMS. All of these databases contain data that is visible to multiple users. So it is necessary to ensure that the data is correct and consistent in all the databases and for all the users.

- **Data Security:**
  Data Security is vital concept in a database. Only authorised users should be allowed to access the database and their identity should be authenticated using a username and password. Unauthorised users should not be allowed to access the database under any circumstances as it violates the integrity constraints.

- **Privacy:**
  The privacy rule in a database means only the authorized users can access a database according to its privacy constraints. There are levels of database access and a user can only view the data. For example - In social networking sites, access constraints are different for different accounts a user may want to access.

- **Backup and Recovery:**
  Database Management System automatically takes care of backup and recovery. The users don't need to backup data periodically because this is taken care of by the DBMS. Moreover, it also restores the database after a crash or system failure to its previous condition.

- **Development and Maintenance Time:**
  DBMS reduces application development and maintenance time. It supports many important functions that are common to many applications, accessing data stored in the DBMS, which facilitates the quick development of application.

2.6 **Data types in the DBMS**

When you create a table or add a field to a table in the database, fields are created with specific data type. Data types are classifications that identify possible values for and operations that can be done on the data, as well as the way the data in that field is stored in the database.
### 2.7 Data model

Database is designed according to certain rules. This logical structure of database is known as a model. Data models define how the data is connected to each other and how they are processed and stored inside the system.

It describes the method of storing and retrieving the data. There are different models like network model, hierarchical model and relational model. Let us see relational model.

**Relational Model:**

The most popular data model in DBMS is the Relational Model. Relational data model is the primary data model, which is used widely around the world for data storage and processing. This model is simple and has all the properties and capabilities required to process data with storage efficiency.

- A transaction is a unit of work that is performed against a database. For example, if you are creating a record or updating a record or deleting a record from the table, then you are performing a transaction on that table. It is important to control these transactions to ensure the data integrity and to handle database errors.

**Properties of Transactions:**

Transactions have the following four standard properties, usually referred to by the acronym ACID.

- **Atomicity**: It ensures that all operations within the work unit are completed successfully. Otherwise, the transaction is aborted at the

---

Table: 2 Data types in DBMS

<table>
<thead>
<tr>
<th>Class</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>CHAR</td>
<td>Holds a fixed length string (can contain letters, numbers, and special characters). The fixed size is specified in parenthesis.</td>
</tr>
<tr>
<td></td>
<td>VARCHAR</td>
<td>Holds a variable length string (can contain letters, numbers, and special characters). The maximum size is specified in parenthesis.</td>
</tr>
<tr>
<td>Numeric</td>
<td>DECIMAL</td>
<td>It can represent numbers with or without the fractional part</td>
</tr>
<tr>
<td></td>
<td>INT</td>
<td>It is used for storing integer values.</td>
</tr>
<tr>
<td>Date</td>
<td>DATE</td>
<td>It holds the date including day, month and year</td>
</tr>
<tr>
<td>Time</td>
<td>TIME()</td>
<td>It holds time. Format: HH:MM:SS</td>
</tr>
</tbody>
</table>

---

Do it yourself

- You have scored 75.56% in the recent examination. Which data type would you prefer to use for storing this data?
point of failure and all the previous operations are rolled back to their former state.

- **Consistency**: It ensures that the database properly changes states upon a successfully committed transaction.
- **Isolation**: It enables transactions to operate independently of and transparent to each other.
- **Durability**: It ensures that the result or effect of a committed transaction persists in case of a system failure.

### 2.8 Introduction of RDBMS

RDBMS stands for Relational Database Management System. In RDBMS a database is considered as a collection of interrelated data.

**Basic Database Concept**

- **Table**: The table is the basic data storage unit in a Relational database. Table consists of columns and rows. A database consists of one or more tables according to which data is stored in a table. Database designer decides the name of the table and titles of columns.
- **Field**: A table consists of information which is stored under different headings, called as fields or columns. Columns are shown vertically in a table. Each field or column has an individual name. Two columns cannot have the same name. In Fig. no. 1, the first row represents the different field names or titles of columns.
- **Record**: All the columns in a table make a row. Each row contains information on individual topics. A record is composed of fields and contains all the data about one particular person, company, or item in a database. Record is also called as a Tuple.
- **Key**: A column or a combination of columns which can be used to identify one or more rows (tuples) in a table is called a key of the table.
- **Primary Key**: The group of one or more columns used to uniquely identify each row of a relation is called its Primary Key.

- **Foreign Key**: It is a field (or collection of fields) in one table that refers to the Primary Key in another table.

**Relationships in database**: Relationships link data from individual tables to increase the usefulness of the database.

A relationship in the context of databases, is a situation that exists between two relational database tables when one table has a foreign key that is used as a reference to the primary key of the other table.

For example, a table called Employees has a primary key called employee_id. Another table called Employee Details has a foreign key which references employee_id in order to uniquely identify the relationship between the two tables.

There are 3 types of relationships in relational database design. They are:

- One-to-One
- One-to-Many (or Many-to-One)
- Many-to-Many

These are explained below.

**One-to-One**

In a one-to-one relationship, one record in a table is associated with one and only one record in another table. For example, in a company database, each employee has only one Person_ID, and each Passport_ID is assigned to only one person.

A one-to-one relationship looks like below in the relationships graph:

![Fig. 2](image)

**One-to-Many (or Many-to-One)**

This is the most common relationship type. In this type of relationship, a row in table City can have many matching rows in table Customer, but a row in table Customer can have only one matching row in table City.

One-to-Many relationships can also be viewed as Many-to-One relationships, depending on which way you look at it.

In the above example, the Customer table is the “many” and the City table is the “one”. Each customer can only be assigned one city,. One city can be assigned to many customers.

![Fig. 3](image)
Many-to-Many

A many-to-many relationship occurs when multiple records in a table are associated with multiple records in another table.

Multiple records in Table Product are linked to multiple records in Table Suppliers.

2.9 Introduction to SQL

SQL is Structured Query Language, which is a computer language for storing, manipulating and retrieving data stored in a relational database. SQL is the standard language for Relational Database Management System. All relational database management systems like MySQL, Base, Oracle, Sybase, Informix, Postgres and SQL Server use SQL as standard database language.


Using SQL You Can:
- Create new databases.
- Create new tables in a database
- Insert records in a database
- Retrieve data from a database
- Update records in a database

2.10 Categories of SQL Commands

Data Definition Language (DDL) Commands

DDL statements or commands are used to define and modify the database structure of your tables or schema. When you execute a DDL statement, it takes effect immediately.

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>USED FOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATE DATABASE</td>
<td>Creates database</td>
</tr>
<tr>
<td>CREATE TABLE</td>
<td>Creates a new table</td>
</tr>
<tr>
<td>ALTER TABLE</td>
<td>Modifies a table</td>
</tr>
<tr>
<td>DROP TABLE</td>
<td>Deletes a table or Database</td>
</tr>
<tr>
<td>DROP DATABASE</td>
<td></td>
</tr>
</tbody>
</table>

Table: 3 DDL Commands

Data Manipulation Language (DML) Commands

Data Manipulation Language (DML) statements or commands are used for managing data within tables.
Basic concepts of database.

We get to know difference between Data and Information.

Database management system (DBMS) is used to create, manipulate and retrieve database.

DBMS is used in various fields like railway, library, schools, colleges, credit transactions, banking.

Benefits of DBMS are data sharing, data integrity, security, consistency, recovery.

RDBMS means relational database management system.

Relations in database are one to one, one to many or (many to one) and many to many.

Categories of SQL Commands: DDL, DML and DCL

DCL is used to control user access in a database. It is related to security issue. It is also deals with the rights and permissions of the database access.
**Question 1** Complete the following activity.

1. Tick whichever box is not valid.

   - Graphic
   - Date
   - Number
   - Text

2. Student wants to create a field pincode in a table, which data type he will choose?

3. Tick the appropriate box.

   - Primary key
   - is also called foreign key
   - Uniquely identifies a record

4. Tick the appropriate circle.

   - Database has
     - Only one record
     - Only single table
     - None of these
     - One or many tables

**Question 2** Observe the field names of a database given below in ‘Column A’ related to Bus reservation. Write suitable data types for each field in front of the respective field in ‘Column B’

<table>
<thead>
<tr>
<th>Column A (Field Name)</th>
<th>Column B (Data Type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passenger Name</td>
<td></td>
</tr>
<tr>
<td>Age</td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td></td>
</tr>
<tr>
<td>Mobile Number</td>
<td></td>
</tr>
</tbody>
</table>

**Question 3** Write the use of following SQL command.

- **Command**: INSERT
- **Use**: __________________

- **Command**: UPDATE
- **Use**: __________________

**Question 4** Create a table for the information given below by choosing appropriate data types. Specify proper primary key for the table

1. Movie
   - (Registration_no, movie_name, Realease_Date)
2. Actor
   - (actor_id, Actor_name, birth_date)
Q.5 Consider the following table Stationary. Write SQL commands for following statements.

Table: Stationary

<table>
<thead>
<tr>
<th>S_ID</th>
<th>S_Name</th>
<th>C_Name</th>
<th>Price</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>NoteBook</td>
<td>ABC</td>
<td>20</td>
<td>50</td>
</tr>
<tr>
<td>002</td>
<td>Pencil box</td>
<td>XYZ</td>
<td>10</td>
<td>80</td>
</tr>
<tr>
<td>003</td>
<td>A4Pages rim</td>
<td>PQR</td>
<td>600</td>
<td>2</td>
</tr>
</tbody>
</table>

1) Write SQL command to create above Table

```
CREATE TABLE Stationary (S_ID INT, S_Name STRING, C_Name STRING, Price INT, Quantity INT);
```

2) Write SQL command to insert above mentioned record in table

```
INSERT INTO Stationary VALUES (001, 'NoteBook', 'ABC', 20, 50);
```

3) To delete above table.

```
DROP TABLE Stationary;
```

Q.6 Answer the following questions.

1) What is a database?
2) What are the advantages of a DBMS?
3) What do you understand by Data Model?
4) What is a primary key?
5) What is DDL (Data Definition language)

Q.7 In a company the data is stored in a table under the following fields Employee number, Last name, Date of birth, Address. Which data type will you use for the above field.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee name</td>
<td>STRING</td>
</tr>
<tr>
<td>Last name</td>
<td>STRING</td>
</tr>
<tr>
<td>Address</td>
<td>STRING</td>
</tr>
<tr>
<td>Date of birth</td>
<td>DATE</td>
</tr>
</tbody>
</table>
```

Q.8 Multiple choice select three correct answers.

1) Valid relationships in RDBMS are
   a) one to one
   b) one to two
   c) one to many
   d) many to two
   e) many to many
   f) one to three

Q.9 Complete the following.

- Use Command
- To remove access rights or privileges from the database
- Extracts data from a table
3.1 Introduction

Online resources have become a part of our day to day life.

The internet is a powerful media to transmit information. The pages of information displayed on the internet are referred to as webpages. The standards and formats for presenting text and graphics on the internet are developed and approved by WWW governing authorities.

The growing demand for attractive presentation of information using electronic means gave rise to the invention of websites.

3.2 How does the web work?

WWW stands for world wide web normally referred to as web. Fig. 3.1 describes the working of web.
3.3 Components of web

Web uses the following Terms :

- **Webpage**: A simple text file created using HTML.
- **Website**: A collection of interlinked web pages containing text, images, audio and videos. For Example, www.ebalbharati.in
- **Web Browser**: A web browser is a software used to view web pages or websites available on the internet For Example Internet Explorer, Google Chrome, Mozilla Firefox.
- **Web Server**: A Web server is an application or a computer that sends webpages over the internet using the HTTP protocol. The functionality of website is managed by web server. For Example Apache, nginx, IIS, etc..
- **URL (Uniform Resource Locator)**: It is an address of a web page on the internet. The web pages are retrieved from the original location with the help of URL.
- **HTTP**: HTTP (HyperText Transfer Protocol) is a protocol used by WWW for client server communication.
- **HTML**: Hyper Text Markup Language, enables to write code for a webpage. All the webpages in a website are linked with one another, with the help of hypertext links.

3.4 Introduction to HTML 5

HTML is a standard language for developing and creating interactive websites, introduced by Tim Berners Lee. HTML documents are created in any text editor for and can be run(executed) on any computer that has a web browser. HTML is compatible with most of the web browsers.

**Basic structure**: HTML tags are keywords enclosed within angular brackets, that define how your web browser must format and display the content. Tags are not case sensitive. Every HTML page is enclosed within two tags `<html>` and `</html>`. This page is divided into two sections internally, head section and body section. Head section contains title of the document which is enclosed within `<Title>` and `</Title>` of `<Head>` and `</Head>`. The actual text of the document is written within `<Body>` and `</Body>`.

**An attribute**: An attribute defines a property for an element, consists of an attribute/value, and appears within the element's start tag. Sometime we need additional information with a tag.

```
<html>
  <head>
    <title>First Page</title>
  </head>
  <body bgcolor = green >
    attribute value of attribute
    This is my first web page
  </body>
</html>
```
Classification of HTML Tags

HTML tags are categorized as:

1. Container tags 2. Empty tags

1. Container Tags: Container Tags are also called paired tags. Container Tags have a beginning tag and an end tag. The end tag is similar to the beginning tag but with a "\" in front of it. For Example <head> </head>, <body> </body>.

2. Empty Tags: Empty tags are standalone tags and do not have an end tag. <Br> is an example of singular tag/Empty tag.

Basic structure of HTML

Purpose of tags:

- <html> and </html>: This tag indicates that the document is an html file.
- <head> and </head>: It includes Title within it, the text within <head> is not displayed on the webpage. This is used for search engine optimization.
- <title> and </title>: The content within this tag is displayed on the title bar.
- <body> and </body>: This tag includes all content which is to be developed in the web browser. Most of the tags are included in this tag.

Structure of web page using HTML5:

The first line on the top, <!DOCTYPE html>, is a document type declaration and it lets the browser know the flavor of HTML.
- `<header>` - Defines a header for a document or a section.
- `<nav>` - Defines a container for navigation links.
- `<section>` - Defines a section in a document.
- `<article>` - Defines an independent self-contained article.
- `<aside>` - Defines content apart from the content (like a sidebar).
- `<footer>` - Defines a footer for a document or a section.
- `<details>` - Defines additional details.

### 3.5 Text formatting element

Text formatting is used to make a document look attractive thereby enhancing it’s appearance. The list of different text level formatting tags are as shown in Table no. 1:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;b&gt;</code></td>
<td>Displays text within it in Bold like Hello.</td>
</tr>
<tr>
<td><code>&lt;i&gt;</code></td>
<td>Displays text within it in italicized manner like Hello.</td>
</tr>
<tr>
<td><code>&lt;u&gt;</code></td>
<td>Displays text with underline like Hello.</td>
</tr>
<tr>
<td><code>&lt;small&gt;</code></td>
<td>Displays text in small font size.</td>
</tr>
<tr>
<td><code>&lt;sub&gt;</code></td>
<td>Displays text in subscript form.</td>
</tr>
<tr>
<td><code>&lt;sup&gt;</code></td>
<td>Displays text in superscript form.</td>
</tr>
<tr>
<td><code>&lt;ins&gt;</code></td>
<td>Anything that appears within <code>&lt;ins&gt;...&lt;/ins&gt;</code> element is displayed as inserted text.</td>
</tr>
<tr>
<td><code>&lt;del&gt;</code></td>
<td>Anything that appears within <code>&lt;del&gt;...&lt;/del&gt;</code> element, is displayed as deleted text.</td>
</tr>
<tr>
<td><code>&lt;mark&gt;</code></td>
<td>The HTML <code>&lt;mark&gt;</code> element defines marked or highlighted text :</td>
</tr>
</tbody>
</table>

#### Program 1:

```html
<!DOCTYPE html>
<html>
<head>
<title>Example of HTML5 text formatting tags</title>
</head>
<body>
<b>This text is bold</b>
<br>
<i>This text is italic</i>
<br>
<mark>This text is marked</mark>
<br>
This is `<sub>` subscript `<sub>` and `<sup>` superscript
<sup><br></sup><br>
<ins>This text is inserted to the document</ins>
<br>
<del>This text is deleted from the document</del>
<br>
</body>
</html>
```

#### Output 1:

This text is bold
This text is italic
This text is marked
This text is subscript and superscript
This text is inserted to the document
This text is deleted from the document.

#### Note:

`<BR>` tag is used to specify a line break.
3.6 Heading levels

HTML provides six levels of heading tags. The range is from 1 to 6. These heading levels are represented as <H1> Text content </H1>. The <H1> tag displays text in bold and with largest heading level whereas <H6> tag displays text in the smallest heading level.

Note: All the heading levels have attribute align with values left, right and center..

For Example: <h1 align="center">Largest heading size which is center aligned. </h1>

Do it yourself

- Create a simple web page using following features.
- Largest heading level ‘Biodata’ text in centre.
- Name in Bold.
- Address in Italics.
- Standard with underline.

Note: Use any text editor to type the code and save it with ‘filename.html’ or ‘filename.htm’. Use a browser to display the output.

3.7 Inserting an image, a horizontal ruled line and a paragraph

- `<IMG>` tag is used to insert an image within a webpage. It uses following attributes:
  - `src`: It is used to specify the path of an image file. The popular extensions of image file are png, jpg and gif.
  - `height`: Specifies height of the image in pixels.
  - `width`: Specifies width of the image in pixels.
  - `alt`: It is referred as alternate text. It specifies the description of the image.
<img> is an empty tag. The syntax used in code is as:

```html
<IMG src="Desert.jpg" height="400" width="400" alt="Desert image">
```

- `<HR>` tag: `<HR>` tag is used to display **horizontal ruled line**. It is a singular tag. The attributes with `<HR>` tag
  - **color**: Sets color for the **horizontal ruled line**.
  - **width**: It specifies the length of the ruled line in % or pixels.
  - **size**: It sets thickness of a ruled line.
- `<P>` tag: It is used to define paragraphs. It is a container tag.

### 3.8 Creating a Table

A table is made up of rows and columns. A table in a webpage is created by using `<table>` tag, which is a container tag. The tags and attributes used to create a table are as follows:

- `<table>`: It is used to indicate the creation of a table.
- `<caption>`: It is used to specify a table heading. It has an `align` attribute which can have 'top' or 'bottom' as its values. Top is the default value.
- `<tr>`: This tag is used to create each row of the table.
- `<th>`: It indicates table heading. `<th>` is generally used for first row column content of the table. It displays content in the bold format. It can be replaced with `<td>`.
- `<td>`: It specifies data within the table (cell content).

**The attributes of table are:**

1. **border**: This attribute is required to display a border for the entire table. It has a numbered value. If border attribute is not specified, a table is created without the border for both table as well as columns.
2. **bordercolor**: It displays border in a specific color.
3. **align**: It aligns the table either to the left, right or center.
4. **bgcolor**: Sets the background color for the table.

**The attributes of the `tr`, `th`, `td`:**

1. **align**: It aligns the text horizontally. The values are aligned to the left, right or center.
2. **colspan**: This attribute is used within `<td>` or `<th>`. It creates a single column spanning across the table. It takes a numbered value, based on the number of columns to be spanned in a table.
3. **rowspan**: This attribute is used within `<td>` or `<th>`. It creates a single row spanning across the table. It takes a numbered value, based on the number of rows to be spanned in a table.

 `<tr>, <th>, <td>` tags can have `bgcolor` attribute for specifying background color to a row or a column respectively.
**Program 3:**

```html
<!DOCTYPE html>
<html>
<head>
<title>Table with 4 rows and 3 columns</title>
</head>
<body>
<table border="2">
  <tr><th>Sr. No.</th><th>Input Device</th><th>Output Device</th></tr>
  <tr><td>1</td><td>Keyboard</td><td>Monitor</td></tr>
  <tr><td>2</td><td>Mouse</td><td>Printer</td></tr>
  <tr><td>3</td><td>Joystick</td><td>Plotter</td></tr>
</table>
</body>
</html>
```

**Output 3:**

<table>
<thead>
<tr>
<th>Sr. No.</th>
<th>Input Device</th>
<th>Output Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Keyboard</td>
<td>Monitor</td>
</tr>
<tr>
<td>2</td>
<td>Mouse</td>
<td>Printer</td>
</tr>
<tr>
<td>3</td>
<td>Joystick</td>
<td>Plotter</td>
</tr>
</tbody>
</table>

**Do it yourself**

- To insert your photograph in a webpage the required tag is ..............
- Can the ruled line be coloured in blue?
- To display table without borders the syntax can be as .................
- Which attribute spans two or more columns of the table?

**Program 4:**

```html
<!DOCTYPE html>
<html>
<head><title>Table with rowspan attribute</title></head>
<body>
<table border="3">
  <tr><td rowspan=2>Colors</td><td bgcolor=red>Red</td></tr>
  <tr><td bgcolor=green>Green</td></tr>
</table>
</body>
</html>
```

**Output 4:**

Colors

- Red
- Green

**Note**

bgcolor attribute is deprecated in Html5 but supported by browsers. The textbook uses it for presentation purpose. Html5 recommends using CSS.
3.9 Creating hyperlinks in a webpage

Hyperlinks are used to connect one document with another document.

In HTML, Links are created by using <a> tag.

Syntax:

```html
<a href = "Mypage. htm"> Click here for my page </a>
```

The href attribute in the above syntax is used to specify address of the file (URL) which needs to be opened on clicking.

HTML Link colours:

- A hyperlink by default appears blue in colour with an underline.
- It is not visited by any user.
- A visited link is underlined and purple.
- An active link is underlined and blue.

Image hyperlink:

Many websites have images as hyperlink. For example The previous arrow is an image which on clicking displays a previous webpage. The arrow is actually an image hyperlink.

Syntax:

```html
<a href = "Mypage2.htm"><img src = "arrow. gif" alt = "Click on arrow"></a>
```
3.10 Forms in HTML

Forms in HTML is used to accept user input. The form in html is created by using <form> element as <form></form>.

Form controls

A form is a collection of different elements also called as controls like textbox, radio button, checkbox, submit button and many more.

Attributes used with form element and Input element.

<Form> tag can have following attributes

- **Name**: It specifies a name to a form.
- **Action**: The action attribute specifies the path where the form is to be submitted. When user clicks on submit button if the action attribute is committed, the action is set to the current page.
- **Method**: The method attribute specifies get or post method to be used when submitting the form data. Method of form are GET or POST.

  i) **GET method**: The default method of submitting form data is GET. The data submitted by using GET is visible in the address bar. It is better for data which is not sensitive. The number of characters in GET method depends on browser.

  ii) **POST Method**: The POST method of sending data does not display the form data in the address bar. So it is a secure method to submit sensitive or personal information. It does not have size limitations as in GET method.

The <Input> tag

The <Input> tag is used to specify the different types of controls by using type attribute. Syntax of using <Input> with type attribute is;

<table>
<thead>
<tr>
<th>Type of control</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Input type = &quot;text&quot;&gt;</td>
<td>Creates a one line textbox</td>
</tr>
<tr>
<td>&lt;Input type = &quot;radio&quot;&gt;</td>
<td>Creates a radio button. The radio button allows one option selection against multiple choices.</td>
</tr>
<tr>
<td>&lt;Input type = &quot;checkbox&quot;&gt;</td>
<td>Creates a checkbox. It allows more than one selection against multiple choices.</td>
</tr>
<tr>
<td>&lt;Input type = &quot;submit&quot;&gt;</td>
<td>Displays a button for submitting the form data to a server.</td>
</tr>
<tr>
<td>&lt;Input type = &quot;password&quot;&gt;</td>
<td>The password input type is used to create text contents in the form of '*' asterik or '•' disc.</td>
</tr>
<tr>
<td>&lt;Input type = &quot;reset&quot;&gt;</td>
<td>The reset control clears the text content entered in the form.</td>
</tr>
<tr>
<td>&lt;Input type = &quot;button&quot;&gt;</td>
<td>It displays push button which activates on events.</td>
</tr>
</tbody>
</table>

*Table: 2 <Input> with values of type attribute*

- **Attributes of <Input>**: Apart from type attribute, there are attributes which are specific to a particular type of controls. The following table specifies the description.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>It describes, the name of the control like text radio etc. eg type = &quot;radio&quot;</td>
</tr>
<tr>
<td>Name</td>
<td>Each input field must have a name. The name attribute is a user defined value. If the name attribute is not specified, the data of that input field will not get submitted.</td>
</tr>
<tr>
<td>Maxlength</td>
<td>This attribute is used with text and password type. It specifies the maximum number of characters which can be entered in a text or password box.</td>
</tr>
<tr>
<td>Size</td>
<td>The 'Size' attribute can be used with text and password type. It specifies the width of the text box.</td>
</tr>
<tr>
<td>Checked</td>
<td>The 'Checked' attribute specifies the default selection for options in a checkbox or radio button.</td>
</tr>
</tbody>
</table>
| Value     | The 'Value' attribute can be used with text, checkbox, radio, submit or reset.  
- When used with text type it specifies default value in a text box.  
- For checkbox and radio it defines value which is sent on submit. |

Table: 3 Attributes of `<Input>`

**<Textarea> tag:**

The `<textarea>` is used to create a textbox with multiple lines. The number of lines and width of the textbox are specified by using rows and cols attribute respectively. The `<textarea>` can have following attributes.

- **name:** It is used to specify name for the textarea. For example name = "ta1".
- **rows:** It specifies the number of lines in a textarea. For example rows = "5"
- **cols:** It specifies the width of a text area.
- **maxlength:** It specifies the maximum number of characters allowed in the textarea.
- **placeholder:** It specifies a short hint that describes the expected value of a textarea. For example placeholder = "your address"
- **required:** It specifies that textarea must be filled out. i.e. It can not be blank.

**Syntax:**

```html
<textarea name = "tal" rows = "5" cols = "30" placeholder = "your address" required> </textarea>
```

**<Select> tag:** `<select>` tag is used to create drop-down list.

The attributes of `<select>` tag are:

1) **Name** - Assigns name to the control.
2) **Multiple** - It allows the user to select more than one value.
3) **Size** - The size attribute is used to specify the number of visible values.

The `<option>` tag inside the `<select>` tag defines the available options in the list.

The attributes of `<option>` tag are:

1) **selected** : To define preselected option, 'selected' attribute is added to the `<option>`

2) **value** : It assigns value to the option specified in the dropdown list.

---

**Do it yourself**

Identify following form elements.

- 
- 
- 

---

**Program 6 :**

```html
<!DOCTYPE html>
<html>
<head><title>Form with Input elements</title></head>
<body bgcolor="orange">
<h1>use of form</h1>
<form>
Enter your name  <input type= "text" Name= "n1 "
maxlength="20"><Br>
Enter your standard : <input type = "radio 
name= "r1 
value= "11 
"11<sup>th</sup>
<input type= "radio 
name= "r1 
value= "12 
" value="12">

Choose your optional subjects :
<input type= "checkbox 
name= "c1 
Value="Hindi">Hindi
<input type= "checkbox 
name= "c2 
Value="German">German
<input type= "checkbox 
name= "c3 
Value="Biology">Biology
<input type= "checkbox 
name= "c4 
Value="IT">IT

<input type= "submit" value= "Submit"><br>
</form></body></html>
```

---

**Output 6 :**

**use of form**

Enter your name
Enter your standard:  
Choose your optional subjects :
- Hindi
- German
- Biology
- IT
<input type="submit" value="Submit">
Note: PHP is server side scripting language. In the above program 'data.php' is the name of PHP file which stores the accepted data.
Client Side Scripting
(For Commerce and Science stream)

3.11 Introduction
There are a variety of scripting languages used to develop dynamic web pages. JavaScript was initially created to “make webpages alive”. They don’t need a special preparation or a compilation to run. Using HTML one can only design a web page but cannot implement any logic on web browsers like addition of two numbers, check any condition, looping statements (for, while), decision making statements (if-else) etc. This is possible by embedding JavaScript block into HTML.

3.12 Scripting language
A script is a list of commands that are executed by a scripting engine. Scripts are used to generate dynamic Web pages on the Web. Scripts can be opened and edited by using a text editor.

Insertion of JavaScript in HTML:
JavaScript can be use for client side or server side scripting language. JavaScript code can be inserted in HTML program between `<script>` and `</script>` tag. type attribute is used to set scripting language. You can place any number of scripts in HTML. There are two methods to insert JavaScript in the HTML. Scripts can be placed in `<body>` or in `<head>` section of an HTML or in both.

Note: It's best practice to terminate JavaScript statements with semicolon (;). It's not required if you write each statement on a new line.

3.13 Variables
The variable is a basic unit of storage in a JavaScript program.

Rules to declare variables:
Variable name may consist of alphabets, digits and underscore and dollar character with following rules:
1. They must start with an alphabet.
2. Uppercase and lowercase are distinct. This means that variable ‘sum’ is not same as ‘SUM’.
3. It should not contain blank space or special symbol except underscore.
4. Standard keywords are not allowed as variable name. For Example document, while.
5. Variable name can be limited up to 255 characters.

Variable name in javascript is declared with keyword ‘var’.

**Syntax:**

```
var variablename;
var variablename, variablename;
```

//To declare more than one variable, variablenames are separated by a comma.

**Example:**

```
var a //variable a has been declared.
var a,b,c // variables a, b and c have been declared.
var z=40,y=100// declaring variables with initialization
```

### 3.14 Data Types

Computer is mainly used to store information and to do complex calculations. When we store information it is in the form of alphabets, numbers or alphanumeric values. JavaScript provides data types to store and use different types of values that are:

1. **Number type:** Numerical value specially belongs to the ‘number’ data type. Number data type stores (holds) both whole number (integer) or decimal point numbers which stores fractional part of number (also called as floating point numbers). Number data type can hold positive as well as negative values.

```
Example:
var y=100000
var z= -67.99
```

2. **String Type:** Strings are used for storing text. Strings must be inside of either double or single quotes.

```
Example :
var x=“Hello”
var str= ‘Information Technology’
```

3. **Boolean Type:** It represents only two values ‘true’ and ‘false’. All relational, conditional and logical operators produce Boolean values true/false or yes/no.

4. **Infinity:** Division by 0 gives you another special value.

```
Example : a=3/0
Result: Infinity
```
5. **null** : In JavaScript null is, just a value which means “nothing”, “empty”, “unknown”. It is supposed to be something that doesn’t exist.

6. **undefined** : JavaScript returns ‘undefined’ when variable which is declared but not assigned. Then java interpreter shows that it is undefined.

### 3.15 Operators

Operators are used to do arithmetic and logical operations. Operators that require one operand is called as unary operator and operators that require two operands are called as binary operator. Most of the operators can be divided into groups: Arithmetic, Relational and Logical operators.

#### 3.15.1 Arithmetic operators:

Arithmetic operators are used in mathematical expressions in the same way that they are used in algebra. For following example consider:

```javascript
var a = 40, b = 4.5;
```

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>a+b</td>
<td>44.5</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td>a-b</td>
<td>35.5</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>a*b</td>
<td>180</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>a/b</td>
<td>8.89</td>
</tr>
<tr>
<td>%</td>
<td>Modulus (It returns remainder after division)</td>
<td>a%b</td>
<td>4</td>
</tr>
</tbody>
</table>

**Table: 4 Arithmetical Operators in JavaScript**

**Note :** - Type your Javascript program in editors and execute it in browser similar to HTML programs.

---

**Program 8 :**

```html
<!DOCTYPE html>
<html>
<head><title>multiplication</title></head>
<body bgcolor="yellow">
<h1> Program to calculate multiplication of two numbers </h1>
<script type="text/Javascript">
    var a,b,c;
    a=76; 
    b=99.45;
    c=a*b; 
    document.write("<br><h1>multiplication of two numbers : "+c+"</h1>"); 
</script></body></html>
```
Here, document. write() is used to display or write content on a web page.

3.15.2 ‘+’ operator in JavaScript:

In JavaScript ‘+’ operator has two meanings, arithmetic addition and string concatenation operator.

Example:
```javascript
var a=15+"Hello"
Result : 15Hello
```
Example:
```javascript
var a=15+7+"Hello"
Result : 22Hello
```

Do it yourself

- Find the result of….
  1. 20+’20’
  2. 10+20+’2’
  3. 10+’2’+’2’

3.15.3 Assignment Operators (=) :

It is important to know that assignment operator is not ‘equal to’ operator. Assignment operator is used to assign value of an expression to a variable. This means that value of an expression on the right hand side is assigned to the single variable on the left hand side. Value of variable may change during the next programming instruction.

Example:
```javascript
var p=400; //assigns value to the variable p
var e=457.930; //assigns value to the variable e
var a=a+7; // evaluates expression a+7 and assigns value to a
var str="Hello"; // assigns string value to variable str
var c=d; //assigns value of d to c
```

Expression: There is a difference between algebraic mathematical equations and computer programming statements. Following statements are valid expressions in algebraic mathematics, but they are invalid in programming languages.

Expression:

```
Example:
```
```
```
```
```
```
```javascript
10=x; //error
x=10; //valid
```

Note: Remember that in a programming statement = operator just evaluates right side expression and assigns it to the left hand side variable so at the left hand side of =, operator always contains a single variable.
3.15.4 Relational Operators:

Relational operators are used to check conditions or comparison of operands. Result of relational operators is Boolean value ‘true’ or ‘false’. They are used in looping and control structures. Following table shows JavaScript relational operators. For result consider the values as: a=10 and b=30…

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td>a&lt;b</td>
<td>True</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td>a&gt;b</td>
<td>False</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than equal to</td>
<td>a&lt;=b</td>
<td>True</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than equal to</td>
<td>a&gt;=b</td>
<td>False</td>
</tr>
<tr>
<td>==</td>
<td>Equal to</td>
<td>a==b</td>
<td>False</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
<td>a!=b</td>
<td>True</td>
</tr>
</tbody>
</table>

Table: 5 Relational Operators in JavaScript

3.15.5 Logical Operators:

Logical operators are used to verify more than one condition at a time or to negate the condition. JavaScript has three logical operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;&amp;</td>
<td>(and)</td>
<td>This operator evaluates to ‘true’ only when all its operands are ‘true’.</td>
<td>var age=25; var salary=50000; if(age&gt;55 &amp;&amp; salary&gt;25000)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(or)</td>
</tr>
<tr>
<td>!</td>
<td>(not)</td>
<td>This unary operator is used to invert the Boolean expression.</td>
<td>var z=0; if(!z==0))</td>
</tr>
</tbody>
</table>

Table: 6 Logical Operators in JavaScript

---

**Do it yourself**

- Which of the following arithmetic expressions are valid in JavaScript.
  a) \( A=\frac{25}{3}\%2 \)
  b) \( X=12.67*-5.0 \)
  c) \( 21\%45-34+12=a+x \)
  d) \( (23/5)+4-7=c \)
  e) \( c+f=45*5/5\%12 \)
3.15.6 Increment (++) and Decrement (--) Operators:

Increment (++) operator in JavaScript is used to increment value of variable by one and Decrement operator in JavaScript is used to decrement value of variable by one. They can be used in two ways:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>++x</td>
<td>Pre-increment</td>
<td>Value of variable x is incremented before it is used in expression</td>
</tr>
<tr>
<td>x++</td>
<td>Post-increment</td>
<td>Value of variable x is incremented after it is used in expression</td>
</tr>
<tr>
<td>--x</td>
<td>Pre-decrement</td>
<td>Value of variable x is decremented before it is used in expression</td>
</tr>
<tr>
<td>x--</td>
<td>Post-decrement</td>
<td>Value of variable x is decremented after it is used in expression</td>
</tr>
</tbody>
</table>

Table: 7 Increment and Decrement Operators in JavaScript

Example:

```javascript
var a=100;
b=++a
output: b=101 and a=101
```

```javascript
var a=100;
b=a++;
output: b=100 and a=101
```

Comments in JavaScript

Comments are non-executable statements in program. Comments are used to provide information or explanation about your programming construct. Statements added in comments are ignored by JavaScript. It supports two types of comments.

1. Single line comment (//............) : Single line comment begin with //. The JavaScript ignores everything from // to the end of the line.

2. Multiline comment : Multiline comments are used to comment on more than one line. It starts with /* and end with */
3.16 Commonly used Built-In Functions in JavaScript

Function is used to perform repetitive tasks whenever required. It is reusable code-block that will be executed when it is called.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>parseInt()</td>
<td>This function is used to parse a string and convert it into a number</td>
<td>Example: parseInt(‘MH100’)    parseInt(‘100’)    parseInt(‘100MH’)</td>
<td>NaN 100 100</td>
</tr>
<tr>
<td>parseFloat()</td>
<td>This function is used to parse a string and convert it into floating point representation</td>
<td>Example: parseFloat(‘MH100’)    parseFloat(‘100.00’)    parseFloat(‘100.2MH’)</td>
<td>NaN 100 100.2</td>
</tr>
<tr>
<td>alert()</td>
<td>This function displays alert popup box with ok button. This is also called as a message box.</td>
<td>Example: alert(“welcome to javascript ”)                  or window.alert(“Hello”)</td>
<td></td>
</tr>
<tr>
<td>prompt()</td>
<td>This function is used when you want input value from user at the time of program execution. It displays ok and cancel buttons. Ok button returns input value, Cancel button returns null value.</td>
<td>Example: var n; n=prompt(“Enter value for n”)</td>
<td></td>
</tr>
<tr>
<td>confirm()</td>
<td>This function displays confirmation message box with ok and cancel button. Ok button returns ‘true’ and cancel returns ‘false’</td>
<td>Example: var ans; ans=confirm(“Do you want to continue”)</td>
<td></td>
</tr>
<tr>
<td>toLowerCase()</td>
<td>This string function used to convert the given string into lower case alphabets</td>
<td>Example: var str=”JavaSCRIPT” str=str.toLowerCase()</td>
<td></td>
</tr>
<tr>
<td>toUpperCase()</td>
<td>This is string function is used to convert given string into uppercase alphabets</td>
<td>Example: var str= “JavaSCRIPT” str=str.toUpperCase()</td>
<td></td>
</tr>
<tr>
<td>isNaN()</td>
<td>It returns true” if given value is not a number. It returns ‘false’ if given value is number</td>
<td>Example: isNaN(CP100)      isNaN(100)</td>
<td></td>
</tr>
</tbody>
</table>

Table: 8 Built-in functions in JavaScript

Note: alert(), prompt() and confirm() are window functions we can use it without the window prefix.

Note: length is a property of string object used to calculate length of string.
3.17 Decision Making Statements

1) if statement:
   Syntax:
   ```javascript
   if(condition)
   {
   statement block ;
   }
   ```
   If the conditional expression given in the parenthesis is true, then the statements within the block will be executed, followed by execution of the remaining program. If the conditional expression evaluates to false, then the statement block will not be executed. Note that if statement block constitutes a single statement, then drawing curly brackets is optional.

2) if else statement:
   Syntax:
   ```javascript
   if(condition)
   {
   statement block ;
   }
   else
   {
   statement block ;
   }
   ```
   If the conditional expression evaluates to true, then true block statements will be executed otherwise false block that is the else part will be executed. At a time either true block or false block will be executed, not both.
**3.18 User Defined Functions**

A function in any scripting and programming languages is small part of program that we require again and again. It helps to make program smaller.

A function is a subprogram designed to perform a particular task. Functions can be called either by an event or by giving call to that function.

**Function definition:**

Rules to declare function name is similar to variable

\[
\text{function functionname(\text{argument1,argument2...})} \\
\{ \\
\text{statement block;} \\
\}
\]

Values to be passed to the function for further processing

---

**Program 10:**

```html
<!DOCTYPE html>
<html>
<head><title>Even Odd</title></head>
<body bgcolor="green">
<h1>Program to check number is even or odd</h1>
<script type="text/Javascript">
 var a,b
 a=prompt("Enter your value:-");
 b=parseInt(a) ;
 // input is converted into number data type
 if(b%2==0)
     alert("Number is even");
 else
     alert("Number is odd");
</script>
</body></html>
```

**Output 10:**

Program to check number is even or odd

![Output Image]

---

**Program 11:**

```html
<!DOCTYPE html>
<html>
<head><title>Function program</title>
<script type="text/Javascript">
 function show()
 {
     alert("Welcome to function");
 }
</script>
</head>
<body bgcolor="green">
<h1>Use of Function in Javascript</h1>
<script language="javascript">
 show(); //calling of function
</script>
</body></html>
```
### 3.18.1 Event Handling:

JavaScript is an event-driven language. Event is an action done by the user or an application. JavaScript's interaction with HTML is handled through events that occur when user or browser manipulates page. When the page loads, it is called an event. When the user clicks a button, that click is also an event. Other examples include events like pressing any key, closing a window, resizing a window, etc.

JavaScript lets you execute a code when events are detected. You can respond to any event using an **Event Handler**, which is just a function that’s called when an event occurs. This event handler may cause button to close windows, messages to be displayed to users, data to be validated and virtually any other type of response. Some commonly used events are:

<table>
<thead>
<tr>
<th>Event Handler</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>onMouseOut</td>
<td>When user moves the mouse away from an element</td>
</tr>
<tr>
<td>onClick</td>
<td>When user clicks an element</td>
</tr>
<tr>
<td>onMouseOver</td>
<td>When user moves the mouse over an element</td>
</tr>
<tr>
<td>onMouseUp</td>
<td>When user releases a mouse button over an element</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Handler</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>onKeyDown</td>
<td>When user presses a key</td>
</tr>
<tr>
<td>onKeyUp</td>
<td>When user releases key</td>
</tr>
</tbody>
</table>

**Table: 9 Event Handler in JavaScript**

**Features of JavaScript**

- Perform input data validation
- It is a lightweight scripting language
- It is case sensitive language
- It makes web pages more interactive
- It can handle date and time effectively
Program 12:

```html
<html><head><title>conditional statement</title>
<script type="text/Javascript">
function check() {
    var age;
    age=form1.t1.value;
    if(age>=18)
        alert("Qualifies for driving");
    else
        alert("Does not qualifies for driving");
}
</script></head>
<body>
<form name="form1">
    Enter your age:-
    <input type="text" name="t1"><br><br>
    <input type="button" value="SUBMIT" onClick="check()">
</form>
</body></html>
```

Program 13:

```html
<html><head><title>Uppercase function</title>
<script type="text/Javascript">
function display() {
    var a;
    a=form1.t1.value
    form1.t2.value=a.toUpperCase()
}
</script></head>
<body>
<form name="form1">
    Enter string value:-
    <input type="text" name="t1"><br><br>
    <input type="button" value="Press button" onKeyPress="display()">
</form>
</body></html>
```
Program 14:

```html
<!DOCTYPE html>
<html>
<head>
<title>Html 5</title>
</head>
<body bgcolor=yellow>
<header>
<h1>HTML5 includes new semantics</h1>
<p>It includes semantic tags like header, footer, nav</p>
</header>
<header>
<h1>Example of complete HTML5 Basics</h1>
<h2>The markup of the future under development.</h2>
</header>
<nav>
<h1>The nav element represents a section of navigation links. It is suitable for either site navigation or a table of contents.</h1>
<a href="/">http://www.w3schools.com</a><br>
<a href="http://www.ebalbharati.in">Balbharti website</a><br>
</nav>
<aside>
<h1>Other education based websites of State</h1>
<a href="http://mahahsscboard.ac.in">State Board website</a><br>
<a href="http://examinfo.mh-hsc.ac.in">Online Exam website</a><br>
</aside>
<section>
<h1>Impressive Web Designing</h1>
<p>The aside element is for content that is tangentially related to the content around it, and is typically useful for marking up sidebars.</p>
</section>
<section>
<h1>Articles on: Article tag</h1>
</section>
<article>
<p>The article element represents an independent section of a document, page or site. It is suitable for content like news or blog articles, forum posts or individual comments.</p>
</article>
<footer>© 2018 Balbharti.</footer>
</body></html>
```
Use of colspan attribute in a table
<colgroup> and <col> Tags

The <colgroup> (short for column group) tag specifies a group of one or more columns in a table for formatting. The <colgroup> tag is used to apply styles to one or more columns. This eliminates the need to apply these styles at individual <TD> level. The <colgroup> tag is written as <colgroup>… </colgroup>

<Col>
<Col> tag is used within <colgroup> tag. The <col> tag has no end tag.

Attribute of <col> tag

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Values</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>span</td>
<td>&lt;col span=“2” style=&quot;background-color:red&quot; &gt;</td>
<td>Span=2 means the styling of red color will be applied to first two columns</td>
</tr>
</tbody>
</table>

Note: bgcolor attribute is deprecated in HTML5 instead it recommends the use of CSS style which will be discussed in XII standard. The browsers still do support bgcolor attribute.

Example: Set the background color of the three columns with the <colgroup> and <col> tags:
HTML <tbody>, <thead>, <tfoot> Tag:

Table rows may be grouped into a table head, table foot and one or more table body sections, using the <thead>, <tfoot> and <tbody> tags, respectively. Browsers can use these elements to enable scrolling of the table body independently of the header and footer. Also, when printing a large table that spans multiple pages, these elements can enable the table header and footer to be printed at the top and bottom of each page.

<thead> tag is used in conjunction with <tbody> & <tfoot> tag. <tr> & <td> tags are used inside <thead>, <tbody> & <tfoot> tag to create data item of respective section. <thead>, <tbody> & <tfoot> helps in search engine optimization.
WWW stands for world wide web normally referred to as web.
Web Browser: A web browser is used to view web pages or websites on the internet. For example, Internet Explorer, Google Chrome, Mozilla Firefox.
Protocol: A protocol is a set of communication standards used for transferring information between computers in a network.

- `<Html>` and `</Html>`: This tag indicates that the document is an html file.
- `<Head>` and `</Head>`: It includes `<Title>` within it, the text within `<head>` is not displayed on the webpage.
- `<title>` and `</title>`: The content within this tag is displayed in a title bar.
- `<body>` and `</body>`: This tag includes all content which is to be developed in the web browser. Most of the tags are included in this tag.

Text formatting elements `(<b>,<i>,<u>,<small>,<sup>,<sub>,<mark>,<del>, <ins>`

HTML provides six levels of heading tags. The range is from 1 to 6
- `<IMG>` this tag is used to insert an image within a webpage
- `<Hr>` this tag is used to display horizontal ruled line
- `<table>`: It is used to indicate creation of a table.
  - `<caption>`: It is used to specify table heading. It has align attribute which can have top or bottom as its values. Top is the default value.
- `<tr>`: This tag is used to create each row of the table.
- `<th>`: It is generally used for first row content of the table. It displays content in the bold format. It can be replaced with `<td>`.
- `<td>`: It specifies data within the table. (cell content)
- `<Form>`: It is used to accept users' entry. It has a collection of different elements or controls.
- `<input>`: It is used to create different controls.
  - Type attribute of `<input>` can have values like text, password, radio, checkbox, submit, reset.
- `<textarea>`: It is used to create text with multiple lines.

JavaScript is scripting language which can be used to develop dynamic webpages. It is an event based scripting language; It is a platform independent language.

- Variables are the basic units of storage.
- JavaScript supports different types of operators such as arithmetic (+,-,*,/,%), relational (<,>,<=,>=,==), logical (&&,||,!) etc.
- if, if…else, are control statements in JavaScript.
- Javascript supports built-In functions like parseInt(), parseFloat(), prompt(), confirm(), alert() etc.
- Javascript supports user defined functions also that can be called either by an event or by giving call to that function.
Q.1 Answer the Following:

1. The data entry operator wants to insert.
   1. Photograph
   2. Write remarks about the photograph
   3. Underline the heading.

   He will use:
   1) `<Image>`
   2) `<Text>`
   3) `<TextArea>`
   4) `<Img>`
   5) `<UL>`
   6) `<U>`

   Select the correct tags from the above and arrange in the sequence.

2. Identify the logical operators in the JavaScript.
   1) OR
   2) AND
   3) `||`
   4) `&`
   5) `&&`
   6) `++`

Q.2 Complete the following Activity:

1. State atleast three attributes of `<Input>`

2. Group the following.

3. Identify the logical operators in the JavaScript.
   1) OR
   2) AND
   3) `||`
   4) `&`
   5) `&&`
   6) `++`

4. Write operator names with symbol in boxes.

5. Complete following program to display multiplication of 6.40 and 300.

```html
<!DOCTYPE html> <html>
<head><title>Series</title></head>
<body>

</body>
</html>
```
```html
<!DOCTYPE html>
<html>
<head>
<title>Heading tags</title>
</head>
<body>
<h1 align=left>Information Technology</h1>
<hr>
<h2 align=center>XI Standard</h2>
<h3 align=right>Division</h3>

var length , breadth;
length=4.5;
breadth=6;
area=1/2*length*breadth;
document.write("Area of triangle is" area);

var x=          ;
var y=             ;
document.write( x          y  );

</body></html>

Q.3 Find out error if any in following javascript code.

```javascript
var length , breadth;
length=4.5;
breadth=6;
area=1/2*length*breadth;
document.write("Area of triangle is" area);

var x=          ;
var y=             ;
document.write( x          y  );
```

Q.4 Solve the following puzzles.

A) Fill the blocks

```
 1) Across
 2. The tag used to create table row.
 4. Tag to create a form

 2) Down
 1. The attribute used to specify the path of a linked document.
```

B) Solve the puzzle by finding words with the help of hint given below.

```
p z c b e p e s
r l o m v d l l
s k n s a r s t
y e f a l s e d
w q i s n a n g
v a r o s d y z
i l m e n c x i
```

1. Boolean value.
2. Keyword used in conditional if statement.
3. Built-In function in JavaScript
4. Function to check given value is number or not
5. Keyword used to declare variable
6. Function used to evaluate given expression

Q.5 Trace the output of following html code.

```html
<!DOCTYPE html>
<html>
<head>
<title>Heading tags</title>
</head>
<body>
<h1 align=left>Information Technology</h1>
<hr>
<h2 align=center>XI Standard</h2>
<h3 align=right>Division</h3>
</body></html>
```
Q.6 Discuss the following and Answer the questions.

1) A Jr. web designer wants to design a webpage to enter the employee name, address. He needs a button to clear the form content and submit the data.
   - Write the different controls he will use to create the webpage.
   - State the tags to be used for the controls.

2) A teacher has asked a student to create a web page to accept number and check whether it is between 50 to 100.
   - List the variable, operators to be used.
   - Specify the built-in function used and structure used.

Q.7 Create webpages for the following.

1) Write a program using HTML to design your class Time Table.

2) Write a program using HTML to create a form and submit it with personal data like name, address and standard.

3) Write a javascript program to accept two numbers and perform addition of two numbers by using mouseover event

Q.8 Complete the following.

Q.9 Write HTML Code for the following table.

<table>
<thead>
<tr>
<th>Place</th>
<th>State</th>
<th>Maximum Temperature in °C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wardha</td>
<td>Maharashtra</td>
<td>47.5</td>
</tr>
<tr>
<td>Akola</td>
<td></td>
<td>46.4</td>
</tr>
<tr>
<td>Khajuraho</td>
<td>Madhya Pradesh</td>
<td>46.4</td>
</tr>
<tr>
<td>Sagar</td>
<td></td>
<td>46.2</td>
</tr>
</tbody>
</table>

Q.10 Multiple choice one correct answer.

1) The default method of submitting form data is............
   a) Post       b) Get
   c) Submit     d) Reset

2) In JavaScript the post increment operator is ............
   a) x++        b) x--
   c) --x        d) ++x
4 CYBER LAW

4.1 Introduction

Today we use computers for storing confidential data from various sectors such as banking, finance, health, personal property etc. We also use internet for transactions of information related to these sectors. But in many situations, the confidential data may be illegally used, and corrupted by unauthorised users. The increase in Internet traffic has led to a higher proportion of legal issues worldwide. So it is very necessary to protect such data from Cyber criminals. Cyber cases related to interference and investigation are increasing at an alarming rate. To control such crimes, it is necessary to follow ethics in field of computer. Cyberlaw is being amended quite regularly.

**Introduction to Cyberlaw**

Cyberlaw is the area of law that deals with the Internet’s relationship to technological and electronic elements, including computers, software, hardware and information systems (IS).

Cyberlaw is the part of the overall legal system that deals with the Internet, cyberspace, and their respective legal issues. Cyber law covers a fairly broad area, encompassing several subtopics including freedom of expression, access to and usage of the Internet, and online privacy.

**Advantages of Cyber Law:**

The IT Act 2000 attempts to change outdated laws and provides ways to deal with cybercrimes. We need such laws so that:

- People can perform transactions over the Internet through credit cards without fear of misuse.
- The IT Act offers the much-needed legal framework so that information is not denied legal effect, validity or enforceability, solely on the ground that it is in the form of electronic records.
- In view of the growth in transactions and communications carried out through electronic records, the Act seeks to empower government departments to accept filing, creating and retention of official documents in the digital format.
- The IT Act has also proposed a legal framework for the authentication and origin of electronic records/communications through digital signature.

---

### Let us Learn

- Introduction to Cyber Law.
- Ethics and Morals.
- Cyber crime and its examples.
- Cyber Safety and Security
- IT Act 2000.
- Case Studies
4.2 Ethics and Morals

- **Ethics**: Also called moral philosophy is the discipline concerned with what is morally good and bad, right or wrong.

- **Morals**: The standards of behaviour; principles of right and wrong behaviour. Thus morals are dictated by society, culture or religion while ethics are chosen by the person himself which governs his life. This chapter introduces the do's and dont's of cyber world.

4.3 Cyber Crime

Computer Crime is alternatively referred to as cybercrime, e-crime, (electronic crime) or hi-tech crime. Computer crime is an act performed by a knowledgeable computer user, sometimes referred to as a **hacker** who illegally browses or steals a company's or individual's private information. In some cases, this person or group of individuals may be malicious and destroy or otherwise corrupt the computer or data files.

Cyber crimes can involve criminal activities that are traditional in nature, such as theft, fraud, forgery, defamation and mischief, all of which are subject to the Indian Penal Code.

**Some Examples of cyber crime**:

Below is a list of the different types of computer crimes -

- **Software Piracy**: Software piracy is nothing but copyright violation of software created originally by an individual or an institution. It includes stealing of codes/programs and other information illegally and creating the imitated copy by unauthorized means and utilizing this data either for own benefit or for profit making.

**Example**: When you download a copy of a licensed software. For example downloading games from a file sharing website without paying for it, it is a software piracy.

- **Unauthorized access**: Gaining access without the users' permission is known as unauthorized access. Authorization means granting access rights to resources, which is related to information security computer security and to access control in particular sector. This is typically possible when the particular software/service is purchased through legal and formal procedure. Attempting to get information (like emails, bank account, intellectual or any other personal and confidential information) from unauthorized person is known as accessing the machine illegally. Examples of unauthorized access are:
  - Hacking financial/bank account related information.
  - Stealing organizational/intellectual information.
  - Illegal monitoring of information owned by other users.
  - Illegal use/break of login and password of other users.

### Do it yourself

- Search Cyber crime related Laws & punishment for it.
Causing intentional irritation to other users by means of damaging software and important information.

- **Copyright violation**: A copyright is a legal right that gives the creator of a literary, artistic, musical, or other creative work the sole right to publish and sell that work. Copyright owners have the right to control the reproduction of their work, including the right to receive the royalty payment for that reproduction. © is copyright symbol.

- **Cracking**: Activity such as decipher codes or passwords and breaking security systems for illegal reasons is called cracking. The cracker will use a program or script known as a crack that has been written specifically to do what they're hoping to achieve.

- **Cyberbully or Cyberstalking**: Cyberstalking is a criminal practice where an individual uses the Internet to systematically harass or threaten someone. This crime can be perpetrated through email, social media, chat rooms, instant messaging client and any other online medium.

- **Phishing**: This a technique of extracting confidential information such as credit card numbers and username password combos by pretending as a legal enterprise. Phishing is typically carried out by email spoofing.

- **Plagiarism**: Plagiarism is presenting someone else's work or idea as your own without their consent. The widespread use of computers and the advent of the internet has made it easier to plagiarize the work of others. For example plagiarism is found in document such as essay, reports etc.

- **Hacking**: Hacking refers to unauthorised intrusion into a computer or a network. Hacker is a person intensely interested in the deep and hidden or concealed working of any computer operating system and programming language. They might discover loopholes within systems and reasons for such loopholes.

**Do it yourself**

- List out Cyber Crime which you find in your surrounding.

**Protecting Ourselves From Cyber Crime**

4.4 **Cyber Safety and Security**

Cyber safety is the safe and responsible use of information and communication technology. It is not just about keeping information safe and secure, but also about being responsible with that information, being respectful of other people online, and practising good 'netiquette' (internet etiquette). In recent years, all systems are exposed to Internet; hence there is increased challenge in maintaining and protecting them from the attackers.

Any organisation plays a key role in promoting internet safety. They are primarily responsible for keeping
systems/ computers/ network devices secure and functional.

The overall sequence from identifying threats to protecting and recovering from Cyber attacks and threats for organisations.

1) **Identify threats and risk**:
   - The system (Computer) operates slowly with more response time.
   - If the system crashes suddenly and unable to download updates.
   - Appearance of new, unfamiliar icons or messages on desktop.

2) **Protection of data**:
   - Protect the network with firewall.
   - Create different logins and strong passwords for different users.
   - Use only verified open source or licensed software and operating systems.
   - Prohibit use of personal devices on the network, such as personal USBs or hard drives.
   - Protect your Wi-Fi Connection with secure password, WEP encryption, etc. Encrypt the network traffic.

3) **Recovery from cyber attack**:
   - After the cyber attack data should be cleaned, recovered and restored, as much as possible.
   - Investigation should be carried out with support from an professional expert.
   - Measures should be taken to avoid re-occurrence.

4) **Educate your stakeholders (students, staff etc)**:
   - Introduce courses/lessons/activities for students and teachers on major components of cyber security and safety.

**Do's and Don’ts for students in cyber world.**

**Do's:**
1. Adhere to copyright restrictions when downloading material from the Internet, including software, games, movies, or music.
2. Report online bullying immediately to the teacher and parents/ or someone you trust.
3. Use a strong and unique password with combinations of numbers, uppercase and lowercase letter and special characters for each account(s) and change your password frequently.
4. Obtain software from trusted sources. Always scan files before opening them.
5. Check to see if the web address begins with https:// whenever you sign in online.
6. Connect only with known individuals.
7. Think twice before you post/like/share something related to sensitive topics like politics, religion etc.
8. Report to the service provider immediately if the account is hacked. If possible deactivate your account.
Don’ts:

1. Don't share your personal information: real name, date of birth, phone number etc. unnecessarily.
2. Don't send your pictures to unknown persons or share them on social media.
3. Don't open emails and attachments from strangers.
4. Don't respond to any suspicious email, instant message or web page asking for personal information.
5. Don't share your password/OTP with anyone.
6. Don't save your username and password on the browser.
7. Don't steal other's information.
8. Don't access or use files without the permission of the owner.
9. Don't copy software which has copyright without the author's permission.
10. Don't bully others online by teasing, threatening, using rude or offensive language, making derogatory or hateful comments.
11. Don't meet unknown (even if they are known only through online interaction) people alone; always inform an adult or a friend.
12. Don't open or download any attachments from an unknown source as they may be harmful.

Security Procedures

- **Encryption**: It is a method of converting the original message into random text, which should be complex to understand and difficult for a hacker to decode. The idea is to ensure security and safety of data and its transmission.

- **SSL (Secure Socket Layer)**: It is the most consistent security model. Through the SSL, transmission of data is encrypted, client-server information is authenticated and also message integrity for TCP/IP connections secured.

- **Firewall**: Firewall refers to network security (Hardware and Software) system which blocks certain type of information, forming a barrier between a trusted and untrusted network. It attempts to block the spread of computer attacks.

Parental guidance:

A lot of cybercrimes revolve around unsuspecting teenagers and school children. Parents play a vital role in ensuring that their children are safe on the internet and not vulnerable to hackers and identity theft. To start with, treat confidential information as confidential. Never reveal sensitive data on the internet. Tell children not to give out personal information like address or telephone number or Facebook password to friends. Ensure, children don’t do that as vital information should be kept secret.
4.5 IT Act of India 2000

In May 2000, both the houses of the Indian Parliament passed the Information Technology Bill. The Bill received the assent of the President in August 2000 and came to be known as the Information Technology Act, 2000. Cyber laws are contained in the IT Act, 2000. IT act 2000 is an Act to provide legal recognition for transaction carried out by means of electronic data interchange and other means of electronic communication.

This Act aims to provide the legal infrastructure for e-commerce in India. The cyber laws have a major impact for e-businesses and the new economy in India. So, it is important to understand what are the various perspectives of the IT Act, 2000 and what it offers.

The Information Technology Act, 2000 also aims to provide for the legal framework so that legal goodness is accorded to all electronic records and other activities carried out by electronic means. The Act states that unless otherwise agreed, an acceptance of contract may be expressed by electronic means of communication and the same shall have legal validity and enforceability.

Salient Features of I.T. Act:
The salient features of the I.T Act are as follows:

- Digital signature has been replaced with electronic signature to make it a more technology neutral act.
- It elaborates on offenses, penalties, and breaches.
- It outlines the Justice Dispensation Systems for cyber-crimes.
- It defines in a new section that cyber café is any facility from where the access to the internet is offered by any person in the ordinary course of business to the members of the public.
- It provides for the constitution of the Cyber Regulations Advisory Committee.
- The IT Act 2000 was amended in 2008 and 2011 and it includes rules for cyber café, cyber security, delivery of services by service provider, Audit of electronic document etc.

Do it yourself

- List out Security techniques to protect your computer data.
- Find out new amendments in IT Act 2000.

Case study

Mr. A checked his account. His account displayed deduction of Rs 30,000. Investigation revealed the money had been transferred to Mr. B’s account. He was informed that he has been a victim of cybercrime. He had given his password and name online by replying to an email sent by the hackers.

The hackers then logged into Mr. A's account and put in their mobile number instead of his. So that, when they did make the transfer, the message alert of the transfer would go to their mobile and not his. Phishing normally begins by, "you
getting an mail-let's say from the bank- saying that some one is trying to hack into you account so you need to re-give your password. So, you click on the link. That website is a fake or the spoofed website you don't realize that your user name and password has gone to the phisher.

Answer the following based on the case study

1) What type of cybercrime does the case study refer to?

2) What does the term hacker mean?

3) How did Mr. A become a victim of Cybercrime?

4) What precautions should been taken in order to avoid this type of fraud?

Case study 2

Source Code Theft Case:

Indian IT company gave bug fixing project for their source code by a US company. One of the employees secretly took away the source code on two CDs tried to sell the source code to other US companies and demanded a price of US $200,000 he also received advance payment of US $20,000 by wire transfer. Case registered against him and got arrested.

Case study 3

Fake Call Frauds

Several instances have occurred wherein people receive phone calls that appear to be from their bank. The caller usually pretends to be a bank presentative or someone from the bank’s technical team. In most cases, the caller sounds professional and provides a convincing reason for calling the customer. After giving a false sense of security, the caller then tricks the victim into giving away their personal and confidential data such as:

- One-Time-Password (OTP), Credit/debit card number, Card’s CVV number, Expiry date, Secure password, ATM pin, Internet Banking login ID and password and other personal information

With all such crucial information at hand, the fraudster can easily carry out illegal financial transactions using the victim’s name.

Students are encouraged to get more recent local case studies and discuss in the class. (Case study 2 and case study 3 are for study purpose)

Do it yourself

- Search some more cases of cybercrime investigated.

Note: Digital Signatures were used for authentication and security of documents. But now a days digital signatures are replaced by e-signature which is based on AADHAAR to check individual authentications.
The increase in internet traffic has led higher level of interference and investigation at alarming rate.

To control cyber crimes it is necessary to give moral and ethical education to computer user at the same time it is necessary to aware users about cyber laws for such crimes.

Cyber law is the area of law that deals with the internet, cyberspace and their respective legal issues.

Cyber crime can involve criminal activity such as unauthorised access to others computer, copyright violation, cracking code and websites, creating malware, software piracy etc.

Every computer user must follow the Do's and Don'ts to live in this cyber world.

Every one should know the IT Act 2000 and its features to safeguard themselves from cyber crime.

Do it yourself

Find out atleast Three more security procedures adopted by during electronic transactions by companies.

Find out new amendments in IT Act 2008.
Q 1. Complete the following web.

Do's for students in the cyber world

Q 2. Complete the following chart.

Examples of unauthorized access
Q 3. Fill following boxes with appropriate cyber crime name

1) Copyright violation of software created originally by an individual.

2) Gaining access without the user’s permission

3) Extracting confidential information by email.

Q 4. Read the following and answer the question.

Rahul lost his pen drive in his college computer lab. His classmate Madhav finds it. He carries it home to return it to him the next day. When Madhav opens it he finds his favourite game. He thinks of making a duplicate copy of the game software.

I) Does Madhav think ethically?

II) What do you think should Madhav do?

III) If he makes a duplicate copy then which cyber crime will he commit?

Q 5. Answer in brief

1) What care should be taken by the user while doing online activities?

2) Define the terms (1) Ethics (2) Moral

3) Explain three examples related to unauthorized access?

4) Explain software piracy and Hacking

Q 6. State true or false

1) Firewall is used to encrypt transmission of data.

2) The standards of behaviour; principle of right or wrong is referred as moral.

3) Hacking bank account related information is an example of software piracy.

4) Phishing is representing some one else's work as own without permission.
Q.7 Match the following.

(A)                         (B)
(1) Copying a game file     (a) Firewall
(2) Law related to internet (b) Cyber threat
(3) Network security        (c) Software piracy
(4) System crashes suddenly (d) Cyber Law

Q.8 Observe the following picture and give your opinion about it by responding to the following questions.

1) Is 'B's response correct or not?
2) What will be the consequences of 'B's reply?
3) Which type of cyber crime does the picture depict?
SKILL ORIENTED PRACTICALS (SOP)
The LibreOffice suite is a collection of application programs for word processing, preparing spreadsheets, creating presentations, drawing diagrams, working with databases & composing mathematical formulae. LibreOffice has been translated (localized) into 40 languages.

LibreOffice Suite consists of following application programs:

<table>
<thead>
<tr>
<th>Logo</th>
<th>Application Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Writer Logo" /></td>
<td><strong>Writer</strong></td>
<td>Writer is a word-processing application. It is compatible with a wide range of document formats. It is used to export work in several formats including PDF. It has extensive WYSIWYG (What you see is what you get) word processing capabilities, it can also be used as a basic text editor. File extension for Writer application is <code>.odt</code>.</td>
</tr>
<tr>
<td><img src="image" alt="Calc Logo" /></td>
<td><strong>Calc</strong></td>
<td>Calc is another name for a spreadsheet, it is used for different kinds of calculations, creating graphs, using different mathematical formulae and many more. File extension for Calc application is <code>.ods</code>.</td>
</tr>
<tr>
<td><img src="image" alt="Impress Logo" /></td>
<td><strong>Impress</strong></td>
<td>Impress is used for creating a presentation. The presentation can be exported as SWF files, allowing them to be viewed on any computer with Adobe Flash Player installed. It is used to create slides with different elements and a wide range of graphic objects. File extension for Impress application is <code>.odp</code>.</td>
</tr>
<tr>
<td><img src="image" alt="Draw Logo" /></td>
<td><strong>Draw</strong></td>
<td>It is a vector graphics editor and diagramming tool which can be used for creating flowcharts. It includes features used for desktop publishing. It can also be used for editing a pdf file. File extension for Draw application is <code>.odg</code>.</td>
</tr>
<tr>
<td><img src="image" alt="Base Logo" /></td>
<td><strong>Base</strong></td>
<td>Base is an open source database management system. Base is designed to allow users to easily create, access, modify, and view databases and their data like-tables, queries, forms, and reports. Base includes software wizards to assist users with various aspects of the program. File extension for Base application is <code>.odb</code>.</td>
</tr>
</tbody>
</table>

**Note For Teacher:** Refer Appendix for installation.

Table 1: Applications and their purpose
LibreOffice Writer

LibreOffice Writer is free and an open-source word processor component of the LibreOffice software package. Writer is similar to other word processors with some identical features.

Double click on the icon of 'LibreOffice Writer' present on desktop. LibreOffice Writer Screen consists of the following parts :

**A) Title Bar :** It is the topmost bar present on the screen of Writer. It displays icon of the application, name of the file and name of the application for example ‘Untitled 1–LibreOffice Writer’. It consists of three buttons on the right corner as minimize, maximize/ restore and close.

**B) Menu Bar :** It is present below the Title bar. It displays the name of different menus such as File, Edit, View, Insert, Format, Styles, Table, Form, Tools, Windows, Help etc. Each menu consists of a drop-down list (Pop-up) of various options related to that particular menu.

**C) Standard Tool Bar :** Standard tool bar consists of different icons which are used for standard operations (regularly repeating operations) like opening a new document, saving a document, printing a document, cut, copy, paste, delete and many more.

**D) Formatting Tool Bar :** Formatting tool bar consists of different icons which are used for formatting the selected text. It displays icons like font name, font size, font color, bold, italics, underline and many more.
E) **Sidebar**: The Sidebar is normally open by default on the right side of the Writer window. The Writer Sidebar contains five decks: Properties, Page, Styles (shown as Styles and Formatting in some installations), Gallery, and Navigator. Each deck can be opened by clicking its corresponding icon on the Tab bar to the right of the sidebar. Each deck consists of a title bar and one or more content panels. A panel is like a combination of toolbar and dialog. Toolbars and Sidebar panels share many functions. If the Sidebar is not visible on screen, it can be made visible from View → Menu. Width of the Sidebar is adjustable.

F) **Status bar**: The Writer status bar is located at the bottom of the workspace. It provides information about the document. It can be hidden by deselecting it in the View menu.

**Basic Operations for Writer, Calc, Impress**:

A) **Creating a New file**: A new file can be created, by choosing.
   - File Menu ➔ New ➔ Select appropriate file type.

B) **Saving a File**: To save a File
   - Choose File Menu ➔ Save ➔ Select the location ➔ Type name of the file ➔ Click on 'Save'.

C) **Opening an Existing File**: To open an existing File,
   - Choose File Menu ➔ Open ➔ Select the location ➔ Select name of the file ➔ Click on 'Open'.

D) **Printing a File**: For printing a File,
   - Choose File Menu ➔ Print ➔ Select Printer name ➔ Select number of copies ➔ Click on 'Print'.

**Commonly used options with Writer, Calc, Impress**:

A) **Cut, Copy and Paste**: These options can be used with help of the Keyboard, Menu bar or Standard toolbar as follows respectively.
   - Press the Ctrl+X(Cut) / Ctrl+C(Copy) / Ctrl+V(Paste) keys.
   - Choose Edit Menu ➔ Cut / Copy / Paste option.
   - Click on the required icon on the Standard Tool bar.

B) **Find, Replace**: These options can be used by choosing
   - Choose Edit ➔ Find & Replace on the Menu bar.
   - Click on icon on the Standard Tool bar.

   ‘Find’ option is used to find a particular text in the document and ‘Replace’ option is used to replace a particular text with some other text.
Various Formatting options in Writer:

A) Formatting the Text: For formatting the text, first select the text and use the required formatting options from ‘Sidebar’ or ‘Formatting Tool Bar’. Character formatting options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Font</td>
<td>![Font Icon]</td>
</tr>
<tr>
<td>* Font Size</td>
<td>![Font Size Icon]</td>
</tr>
<tr>
<td>* Bold</td>
<td>![Bold Icon]</td>
</tr>
<tr>
<td>* Italics</td>
<td>![Italics Icon]</td>
</tr>
<tr>
<td>* Underline</td>
<td>![Underline Icon]</td>
</tr>
<tr>
<td>* Strike through</td>
<td>![Strike through Icon]</td>
</tr>
<tr>
<td>* Toggle Shadow</td>
<td>![Toggle Shadow Icon]</td>
</tr>
<tr>
<td>* Increase Font Size</td>
<td>![Increase Font Size Icon]</td>
</tr>
<tr>
<td>* Decrease Font Size</td>
<td>![Decrease Font Size Icon]</td>
</tr>
<tr>
<td>* Font color</td>
<td>![Font color Icon]</td>
</tr>
<tr>
<td>* Highlight Color</td>
<td>![Highlight Color Icon]</td>
</tr>
<tr>
<td>* Set Character Spacing</td>
<td>![Set Character Spacing Icon]</td>
</tr>
<tr>
<td>* Superscript</td>
<td>![Superscript Icon]</td>
</tr>
<tr>
<td>* Subscript</td>
<td>![Subscript Icon]</td>
</tr>
</tbody>
</table>

B) Formatting the Paragraph: Select the paragraph and then select the required formatting option from ‘Sidebar’ or ‘Formatting Tool Bar’. Paragraph formatting options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Align Left</td>
<td>![Align Left Icon]</td>
</tr>
<tr>
<td>* Above Paragraph Spacing</td>
<td>![Above Paragraph Spacing Icon]</td>
</tr>
<tr>
<td>* Align Center</td>
<td>![Align Center Icon]</td>
</tr>
<tr>
<td>* Below Paragraph Spacing</td>
<td>![Below Paragraph Spacing Icon]</td>
</tr>
<tr>
<td>* Align Right</td>
<td>![Align Right Icon]</td>
</tr>
<tr>
<td>* Line Spacing</td>
<td>![Line Spacing Icon]</td>
</tr>
<tr>
<td>* Justified</td>
<td>![Justified Icon]</td>
</tr>
<tr>
<td>* Increase Indent</td>
<td>![Increase Indent Icon]</td>
</tr>
<tr>
<td>* Decrease Indent</td>
<td>![Decrease Indent Icon]</td>
</tr>
<tr>
<td>* Toggle Bulleted List</td>
<td>![Toggle Bulleted List Icon]</td>
</tr>
<tr>
<td>* Switch to Hanging Indent</td>
<td>![Switch to Hanging Indent Icon]</td>
</tr>
<tr>
<td>* Background Color</td>
<td>![Background Color Icon]</td>
</tr>
<tr>
<td>* Before Text Indent</td>
<td>![Before Text Indent Icon]</td>
</tr>
<tr>
<td>* Increase Paragraph Spacing</td>
<td>![Increase Paragraph Spacing Icon]</td>
</tr>
<tr>
<td>* After Text Indent</td>
<td>![After Text Indent Icon]</td>
</tr>
<tr>
<td>* Decrease Paragraph Spacing</td>
<td>![Decrease Paragraph Spacing Icon]</td>
</tr>
<tr>
<td>* First Line Indent</td>
<td>![First Line Indent Icon]</td>
</tr>
</tbody>
</table>

Table 2: Formatting icons and text

Table 2: Paragraph Formatting icons and text
Inserting a Table:

Table is used to display the text in proper and organized manner.

- Choose Table Menu → Insert Table → Select number of rows and columns → Insert.

Mail Merge:

Mail Merge is a powerful tool for writing a personalized letter or E_Mail Message to many people at the same time. It imports data from another data source such as a database, spreadsheet, or table into document. This feature is usually employed in a word processing document which contains fixed text (which is the same in each output document) and variables (which act as placeholders that are replaced by text from the data source).

Steps to do this activity are:

1. Open a new blank Document → Click on ‘Tools’ Menu → Select ‘Mail Merge Wizard’ option → Click on ‘Use the current document’ option → Click on ‘Next’ Button.
2. Click on ‘Letter’ option → Click on Next.
3. In Next Window, in ‘Insert Address Block’ section under first point click on ‘Select Different Address List’.
4. In Next window, ‘Select Address List’, Click on ‘Create’ Button.
5. In ‘New Address List’ window, click on ‘Customize’ button.
6. In ‘Customize Address List’ window select a field which is not required for database and click on ‘Delete’ button → If you want to add a new field then click on ‘Add’ button → Type a name in ‘Element Name’ box → Click on ‘Ok’ button → After selecting the required fields click on ‘Ok’ button.
7. Now in ‘New Address List’ window type the required information in the fields → Click on ‘New’ button to add a new record → After filling all records → Click on ‘Ok’ button → in next window type name for the database in ‘File Name’ box → Click on ‘Save’ button → Click on ‘Ok’ button → Click on ‘Next’ button → Click on ‘Next’ button.
8. In next window, remove ✔ from 'Insert Personalized Salutation' → select required 'General Salutation' → Next → Next → click on ‘Finish’ button.

Now in the present document after salutation type invitation letter matter → Click on ‘Format’ Menu → Click on ‘Page’ → Click on area → select any one page background like Color/Gradient/ Bitmap/Pattern → Click on ‘Apply’ → Click on ‘Ok’ → Click on ‘Insert’ Menu → if desirable insert an Image/ Shape → Below Formatting Tool Bar a ‘Mail Merge Tool Bar’ will appear. → Click on ‘Save Merged
Documents’ option  → Type name for that new document in ‘File Name’ box  → Click on ‘Save’ button.

Now open that saved (merged) document. In the document the number of letters created are equal to the number of addresses present in the ‘Address List’.
Example: Invitation to Parents for School Exhibition.

Fig. 2: Screen before merging text and data source.
Check Spelling:

This option is used to correct mistakes identified by the Writer Application and displayed as green and red wavy lines for grammatical and spelling mistakes respectively.

- Choose Tools Menu → Spelling → with the help of various options correct the spelling as well as grammatical mistakes.

LibreOffice Calc

LibreOffice Calc is the spreadsheet component of the LibreOffice software package. It is used for doing calculation and analysis of data.

Double click on the icon of 'LibreOffice Calc' present on desktop. The screen of Calc will be displayed as follows.
Various activities in Spreadsheet:

A) Simple calculations: In Calc, formula can be created for doing simple calculations.

Steps:

1. First fill up the numeric data in cells
2. Click inside the cell where the result has to be calculated.
3. Type ‘=’ sign
4. To calculate sum, type the word ‘sum’
5. Type ‘(’ bracket.
6. Type the range of cells [ while writing the range of cells, write the starting cell’s address followed by the ‘:’ sign and then the last cell’s address]
7. Type ‘)’ bracket
8. Press ‘Enter’ key.

Another method to calculate the sum is, place the cursor in the cell where result should be calculated and type ‘= B2 + C2’ press ‘Enter’ key.

In Calc built-in functions as well as user defined functions are available for easy calculations. Built-in functions means functions provided by the application. User defined functions means user writes function according to the requirements. Some common built-in functions are count(), average(), min(), max(), mode().

**B) AutoFill Series:** Various series can be created by using 'AutoFill Series' option like Number (Number, Table, Odd, Even), Weekdays, Month Names.

![Fig. 6: AutoFill Series.](image)

**C) Sort:** Sort option is used to arrange the records in the alphabetical order. The order may be ascending or descending. The same is possible for numeric fields.

**D) Create a Chart:** Chart is the graphical representation of numeric data. Various types of charts can be inserted such as pie chart, bar chart, line chart, column chart. Steps are as follows.

1. Create a table with some records → select the complete table → Click on ‘Insert’ menu → Click on ‘Chart’ option.
2. A window will appear, which starts a chart wizard → select the ‘Chart type’ → put check mark to ‘3D look’ if you want a 3D view → select ‘Shape’ → click on ‘Next’ button.
3. In next window ‘Data Range’ is displayed, click on ‘Next’ button.
4. In next window ‘Data ranges for each individual series’ is displayed. click on ‘Next’ button.
5. In next window, type the required information for the fields like Title, Sub title, X-Axis, Y-Axis, Z-Axis → Click on ‘Finish’ button.

**E) AutoFilter (Standard Filter)**: Filter option is used to filter the record according to some value or some criteria. To do this activity-

- Select the records → Click on ‘AutoFilter’ icon → Click on any one field’s drop down list → Click on ‘Standard Filter’ [It can be selected from Data → More Filters] → Standard Filter → Select ‘Field Name’ → Select condition → Type a value → Click on ‘Ok’ button.

**LibreOffice Impress**

LibreOffice Impress is one of the application in LibreOffice Suite, used to create a presentation. Presentation is a powerful tool to express the knowledge.

Double Click on the icon of 'LibreOffice Impress' present on Desktop. The screen of Impress will be displayed as follows.

![Fig. 7: LibreOffice Impress Screen.](image)

**Creating a presentation:**

**A) Preparing a slide**: When a new blank presentation is started, a blank slide is displayed on the screen. Some instructions are provided on the slide. Follow the instructions to complete the slide. While creating a presentation, type only the main points which are to be explained at the time of presentation.

A new slide can be inserted by using Keyboard, Menu bar or icon present on Standard Toolbar as follows respectively.

- Press the 'Ctrl + N' keys.
• Choose Slide  ➔ New Slide from the Menu bar.
• Click on the New Slide icon on the Standard Toolbar.

B) Setting Background: A slide can have a background of an image or a colour.
• Choose Slide Menu ➔ Set Background Image/Properties.

C) Slide Transition: Slide transition are the effects given to complete slide. Click on the slide for which effects to be given.
• Choose Slide Menu ➔ Select 'Slide Transition' option

D) Custom Animation: Custom animation are the effects for objects present on the slide.
• Click on any object present on Slide ➔ From Side bar Select Custom Animation ➔ Choose Category, Effect, Direction, Duration etc.

E) Slide Show: Slide Show option is used to see the presentation on a full screen with all effects. A slide show can be started from the Keyboard, Menu Bar or icon present on the Standard Toolbar as follows respectively.
• Press the 'F5' Function key.
• Choose Slide  ➔ Start From First Slide from Menu bar.
• Click on the ‘Start From First Slide’ icon on the Standard Toolbar.
LibreOffice:

**SOP 1: Create a Resume**

The resume should contain the following:

- Title at the center with applicable font and size.
- It should contain points such as Name, Address, Mobile Number, Date of Birth, Nationality, Caste, Category, Hobbies etc. Add some extra points.
- For educational qualifications a student should insert a table.
- At the end students should write a few lines about their aim.

**SOP 2: By using Mail Merge send an invitation for your birthday party.**

- Use mail merge feature.
- Send invitation to at least 5 friends.

**SOP 3: Create a mark list. The mark list should display:**

- Fields as Name, Math, Physics, Chemistry, Biology, Total, Percentage.
- Below each subject find out the lowest marks and highest marks.
- Enter minimum 10 records.
- Declare the first three ranker students.
- Create a chart based on the above data.

**SOP 4: Create an Informative presentation on your college.**

- Presentation should contain minimum 8 slides.
- One slide should contain a chart.
- One slide with an image.
- Each slide should contain custom animation & slide transition effect.
**Skill Set 2 - HTML 5**

**SOP 1:** Write a program using HTML with following specifications.
- The background colour should be green.
- The text colour should be red.
- The heading should be large in size as 'My First Web Page'.
- Display a horizontal line after the heading.
- Display your name in Bold, address in Italics and standard as 11\textsuperscript{th}.

**SOP 2:** Create a web page with, following specification.
- Image of any scientist with an alternate text as his name.
- Create a paragraph related to information of that scientist.
- Create a table of his/her inventions.

**SOP 3:** Create a webpage with following specification.
- Display heading 'Application Form' in highest heading with center alignment.
- Accept name, standard 11\textsuperscript{th} or 12\textsuperscript{th} with only one selection choice.
- Submit the form.

**SOP 4:** Write a program using HTML with the following specification.
- A webpage with details about a class with total number of students-100, (Boys-50), Girls-50 in tabular form.
  
  **Table Example:**
  
<table>
<thead>
<tr>
<th>Number of Students</th>
<th>Boys</th>
<th>Girls</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>
  
- Link this page to another page as follows.

<table>
<thead>
<tr>
<th>STD - XI</th>
<th>Stream - Science</th>
<th>Div - A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Demo.html</td>
<td></td>
</tr>
</tbody>
</table>
SOP 1: Create JavaScript program for the following using appropriate variables, JavaScript inbuilt functions and control structures.

- To accept integer and display the result by multiplying it with 3.
- To accept two integers and display larger number of them.
- To check whether, user entered number is positive or negative.

SOP 2: Create JavaScript program for the following using appropriate variables, JavaScript inbuilt functions and control structures.

- To accept two positive or negative numbers and check whether they are equal or not.
- To accept number and display square of it.
- To check whether the accepted integer is multiple of 3 or multiple of 7.

SOP 3: Create JavaScript program for the following using appropriate variables, JavaScript inbuilt string functions and control structures.

- To accept string and calculate its length.
- To accept string and display it into lowercase and uppercase.
- To check whether the length of string is 4 or greater.

SOP 4: Create event driven JavaScript programs for the following using appropriate variables, JavaScript inbuilt functions and control structures.

- To accept number and validate if the given value is a number or not by clicking on the button.

Enter Value:-

Check

- To calculate addition and division of two numbers.
Introduction to accounting software:

In computerised accounting complete book keeping is done which enables user to record all types of transactions including receipts, payments, income and expenses, sales and purchases, debit notes, credit notes, adjustment journals, memorandum journals and reversing journals. Various open-source accounting software are available in market such as GNUKhata, GNUCash, Turbo Cash, Ledger SMB, Money Manager. You can use any accounting software. This book has introduced GNUKhata which is one of the open source software.

Golden rules of accounting:

There are three types of accounts:

1. **Personal Account**: Personal account is related with Individual’s, Organizations and Institutions accounts. Example Persons capital account, Bank account etc.
   - **Rules of Personal account**
     - Debit the Receiver
     - Credit the Giver

2. **Real Account**: Accounts relating to assets of business are called Real account. Real accounts which are tangible or intangible in nature. Example Furniture, Goodwill, Trademark etc.
   - **Rules of Real account**
   - Debit what comes in
   - Credit what goes out

3. **Nominal Account**: Nominal Account is related with all the expenses, losses, and incomes and gains of the business. Example wages, salary, advertisement, interest received etc.
   - **Rules of Nominal Account**
   - Debit all Expenses and Losses
   - Credit all Incomes and Gains
Open source accounting software package-GNUKhata

GNUKhata is a free and flexible software for accounting and inventory management. It provides solutions for basic book keeping. It has various version such as GNUKhata 4.0, GNUKhata 5.0 and GNUKhata 6.0. We will be using GNUKhata 6.0 in this textbook. This software freely available on https://www.gnukhata.in.

Features of GNUkhata:

1. GNUkhata is free and open source accounting software.
2. GNUkhata is based on double entry book keeping.
3. GNUkhata allows you to comprehensive financial reports-ledgers, trial balance, profit and loss account, balance sheet.
4. GNUkhata provides source document attachment facility in vouchers.
5. GNUkhata gives linking facility. To linking of sales and purchase transactions to invoices.
6. GNUkhata allows you to export and import spreadsheet.
7. GNUkhata gives password security and data audit facility.
8. Unique dual ledger facility.
9. Inventory includes invoicing and cash memo.
10. It can be easily transformed into Indian languages.
11. It is GST complaint.

Opening screen of GNUkhata

When we open GNUkhata for the first time it is called opening screen or welcome screen of GNUkhata.

Fig. 1 Opening Screen Of GNUKhata
1) Company Setup wizard

1. **Create Company**: The first step in GNUKhata is to create an organization. Click on ‘Company Setup Wizard’ (or press Shift + Control + C).

![Company Setup Wizard](image)

**Fig 2: Company Setup Wizard**

While creating a company the following details are to be given:

- **Company Name**: Enter the name of the company.
- **Company Case**: Select appropriate case for example as-is, upper case, lower case or title case.
- **Company Type**: Select the company Type either ‘Profit Making’ or ‘Not For Profit’.
- **Financial year**: Enter financial Year of the company.
- **How Would you like to use GNUKhata?** It displays following three options, select Accounting only.
  - Accounting only.
  - Invoicing with Billwise Accounting.
  - Inventory with Invoicing and Billwise Accounting.
- **Uncheck ‘Use Simple Mode for Receipt and Payment Vouchers’ and ‘Use System Generated Voucher Numbering’**.
- **Proceed Button**: It allows you to proceed to create company profile.
2. **Company Profile**:

![Company Profile Screen](image)

**Fig 3: Company profile screen**

Enter appropriate company information in the above fields.

3. **Create Admin**: The next step is the ‘Create Admin’ which is mandatory. Fill all the fields and click on ‘Create & Login’.

![Admin Creation Screen](image)

**Fig. 4 Admin Creation Screen**
4. **Admin Dashboard**: After login, following admin dashboard appears.

![](image1.png)

**Fig. 5 : Admin Dashboard**

2) **Select Existing Company**

You can select already created company using ‘Select Existing Company’ Option on Opening Screen as shown in **Fig. 1**

![](image2.png)

**Fig. 6 : Select Existing Company**

3) **Delete Existing Company**

Click on Hamburger Menu on left top corner of dashboard. Click on ‘Administration → Delete Company’.

**Groups and sub-groups in GNUKhata**

Group is a type of account. Groups are helpful for classifying and identifying account head and also to get summarized information. Group of account is a method of organizing the large number of ledger accounts into sequential arrangement. GNUKhata has 13 groups.
### BALANCE SHEET GROUPS, SUB-GROUPS AND LEDGER ACCOUNTS

The summary of balance sheet groups, sub-groups and ledger accounts are given below.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Sub-Group Name</th>
<th>Ledger Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Capital / Corpus</td>
<td>None</td>
<td>• Capital Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partner’s Capital Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Share Capital Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Capital Fund</td>
</tr>
<tr>
<td>(2) Current Assets</td>
<td>(1) Cash as Bank</td>
<td>• Bank Account</td>
</tr>
<tr>
<td></td>
<td>(2) Cash in hand</td>
<td>• Cash Account</td>
</tr>
<tr>
<td></td>
<td>(3) Inventory</td>
<td>• Petty Cash Account</td>
</tr>
<tr>
<td></td>
<td>(4) Loans and Advance</td>
<td>• Closing Stock (System Generated)</td>
</tr>
<tr>
<td></td>
<td>(5) Sundry Debtors</td>
<td>• Stock at the Beginning (System Generated Ledger Account)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Short Term Loans and Advances given to Employees.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prepaid Expenses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• All Debtors/Customers Account</td>
</tr>
<tr>
<td>(3) Current Liability</td>
<td>(6) Provisions</td>
<td>• Account of PF, ESI, TDS dues, etc.</td>
</tr>
<tr>
<td></td>
<td>(7) Sundry Creditors for Expenses</td>
<td>• Provision for Bad debts</td>
</tr>
<tr>
<td></td>
<td>(8) Sundry Creditors for Purchases</td>
<td>• Provision for Income Tax</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Outstanding Expenses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• All Suppliers / Creditors Account</td>
</tr>
<tr>
<td>(4) Fixed Assets</td>
<td>(9) Building</td>
<td>• Building Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Office Building Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Factory Building Account</td>
</tr>
<tr>
<td></td>
<td>(10) Furniture</td>
<td>• Furniture Account</td>
</tr>
<tr>
<td></td>
<td>(11) Land</td>
<td>• Shop Furniture Account</td>
</tr>
<tr>
<td></td>
<td>(12) Plant &amp; Machinery</td>
<td>• Land Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Machinery Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Plant Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Plant &amp; Machinery Account</td>
</tr>
<tr>
<td>(5) Investments</td>
<td>(13) Investment in Bank Deposits</td>
<td>• Bank Fixed Deposit</td>
</tr>
<tr>
<td></td>
<td>(14) Investment in Shares &amp; Debentures</td>
<td>• Investment in Shares</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Investment in Debentures</td>
</tr>
<tr>
<td>(6) Loans (Asset)</td>
<td>None</td>
<td>• Accounts of all Long Term Loans given by the organisation</td>
</tr>
</tbody>
</table>
Table 1: Summary of Balance Sheet groups

**PROFIT & LOSS OR INCOME & EXPENDITURE ACCOUNT GROUPS, SUB-GROUPS AND LEDGER ACCOUNTS**

The summary of Profit and Loss account groups and sub groups are given in Table 1.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Sub-Group Name</th>
<th>Ledger Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>(7) Loans (Liability)</td>
<td>(15) Secured</td>
<td>• Bank Loan</td>
</tr>
<tr>
<td></td>
<td>(16) Unsecured</td>
<td>• Other secured loans</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Loan from Partners</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Loan from Manager(s), etc.</td>
</tr>
<tr>
<td>(8) Miscellaneous</td>
<td>None</td>
<td>• Preliminary Expenses</td>
</tr>
<tr>
<td>Expenses (Assets)</td>
<td></td>
<td>• Pre-operation Expenses, etc..</td>
</tr>
<tr>
<td>(9) Reserves</td>
<td>None</td>
<td>• Retained Earnings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• General Reserves</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reserves and Surplus</td>
</tr>
</tbody>
</table>

The summary of Profit and Loss account groups and sub groups are given in Table 1.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>Sub-Group Name</th>
<th>Ledger Account</th>
</tr>
</thead>
</table>
| (1) Direct Income | None | • Sales
<p>|              |          | • Professional Fees                                 |
|              |          | • Profit and Loss Account or Income &amp; Expenditure Account (System Generated Ledger Account) |
| (2) Indirect Income | None | • Bad debt received                                |
|              |          | • Commission Received                              |
|              |          | • Discount Received                                |
|              |          | • Income from Investment                           |
|              |          | • Rent Received                                    |
|              |          | • Interest Received, etc..                         |
| (3) Direct Expense | None | • Wages Carriage Inward                            |
|              |          | • Coal, Gas &amp; Water of Factory                     |
|              |          | • Factory Expenses (Lighting, Power, etc)          |
|              |          | • Freight                                          |
|              |          | • Import Duty                                      |
|              |          | • Octroi                                           |
|              |          | • Factory Expenses                                 |
|              |          | • Opening Stock Account (System Generated Ledger Account) |
|              |          | • Purchases                                        |
|              |          | • Sales Return, etc..                               |</p>
<table>
<thead>
<tr>
<th>Group Name</th>
<th>Sub-Group Name</th>
<th>Ledger Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4) Indirect Expense</td>
<td>None</td>
<td>• Office Expenses Salary&lt;br&gt;• Rent&lt;br&gt;• Insurance&lt;br&gt;• Audit Fee&lt;br&gt;• Electricity&lt;br&gt;• Depreciation&lt;br&gt;• Bad debt&lt;br&gt;• Telephone Charge&lt;br&gt;• Commission Allowed&lt;br&gt;• Discount Allowed&lt;br&gt;• Export Duty&lt;br&gt;• Interest on Loan&lt;br&gt;• Legal Expenses&lt;br&gt;• Postage and Telegram&lt;br&gt;• Printing and stationery, etc..</td>
</tr>
</tbody>
</table>

Table 2. Summary of Profit and Loss groups, Sub-groups and Ledgers

**Ledger:**

A Ledger account contains a record of all transactions relating to an asset, liability, capital, and an item of expenditure or revenue. It has to be created under any of this group.

**How to create a account (Ledger account) using GNUKhata**

1. **Create an account:** GNUKhata allows you to create single account at a time. Click on Hamburger Menu (≡) available at left top corner of the dashboard. It displays the options as shown in **fig. no. 7**.

![Fig. 7 Admin Dashboard Menu](image-url)
Click on the Master → Account. It allows you to create account as shown in Fig. 8.

**Fig. 8 Group Creation Screen**

Select appropriate group name, sub-group name and enter account name and click on save. You can also create Multiple Accounts.

**Note:**

1. You can not create a new Group but you can create a new Sub-Group of any Group in addition to the existing ones or where there is none.
2. You can not delete a Group or Sub-Group. Having created a new Sub-Group you may not use it.
3. You can not create Sub-Group of Sub-Group.

2. **Edit Account:** To edit/delete account, click on ‘Edit Account’ and select appropriate account from ‘List of Accounts’ drop-down.

3. **List Accounts:** To view all the accounts, click on ‘List Accounts’.
**SOP 1 : Use of Accounting Package to create a company.**

**Create a company with the following particulars.**

- **Company Name**: B.B Enterprises
- **Case**: Upper Case
- **Company Type**: Profit Making
- **Financial Year**: 01-04-2019 to 31-03-2020
- **Use GNUKhata for**: Accounting Only

**Create profile with relevant data for any company. Create Admin account for the company.**

**SOP 2 : Create ledger accounts using accounting Package.**

**Create ledger accounts for the following and allocate proper groups.**

1. Import duty
2. Insurance
3. Machinery
4. Audit Fee
5. Purchase
6. Sales
7. Telephone charges
8. Interest Received
9. Salary
10. Professional fees

[Skill Set 4 - Accounting Package]
Introduction

Digital content can be in any form. We have different types of files, such as images, videos, audio, text files, software program files which can be compiled and made executable. Following is the list of contents along with its example

1. Images files
2. Blogs – HTML files with Images and Videos in it.
3. Audio Files – Mp3 and various other format files etc.
4. Videos files –

In this SOP we are going to learn GIMP, Inkscape

GIMP

GIMP (GNU Image Manipulation Program) was created in 1995 as a computer science project by students, Spencer Kimball and Peter Mattis. Today GIMP has become a very sophisticated software with plenty of documentation and support. GIMP is a Free and Open Source Software. You can freely distribute the program as well as its source code to any number of users. You can even study the source code and enhance it. GIMP runs on Linux and most of the other desktop Operating Systems.

Fig 1: GIMP Opening Screen
Gimp Opening Screen (The appearance may vary depending upon your version)

GNU/Linux distribution already comes with a GIMP package. Installing through package manager is a preferred method of installing GIMP, as the distribution maintainers take care of all the dependencies and bug fix updates.

GIMP is very easy to learn. The opening screen of GIMP is shown above. Please ensure that you use the 'Single Window Mode' which is suitable for beginners. To do this, tick Windows -> Single-Window Mode if it is not ticked already.

Fig 2: Single Window Mode Option

GIMP toolbox contains set of tools. These tools can be used to do various operations on images. Tool icons visually describe the corresponding operations. We will cover a few of them.

Students are required to explore the other tools by using them and referring to the GIMP documentation, manual and web tutorials which are freely available.

The most frequently used tool is Foreground and Background colour tool. The upper rectangle represents foreground colour while the lower represents background.

Fig 3: GIMP Toolbox

Clicking on each of the rectangles gives a colour selection dialog from which users can choose required foreground or background color. Note that each colour selection is represented by set of numbers. You can note down these numbers and reproduce the colour at any time.

Let us do a small activity. We will create a colourful baloon with some text on it.

Step 1: Create a blank image, also called as ‘Canvas’. File->New (or Ctrl+N).

Fig 4: Canvas Creation
We start with a new blank image of size 640 x 400 pixels. The new image will have white background and black foreground.

This 640 x 400 image will be the surface of our balloon.

We want our balloon to have very attractive colours. So let us fill the whole image area with some bright colour. We can use single flat colour or even mixture of few colours. Here we will use gradient colour. Gradient colour is a gradually fading mixture of two colours.

**Step 2:** Change Foreground and Background colour with colours of your choice. The tool will show you the colours you have chosen in the form of small icon.

**Step 3:** Now select the *Blend Tool* (short cut L) from the tool box and drag the mouse from left to right on your canvas. After you release the mouse, the canvas will be filled by the gradient of foreground and background colour. The balloon made up of this canvas will look nice. But we will decorate the canvas further by putting some text and coloured ovals on it.
Step 4: Next click on Text tool (short cut T) The resulting dialog will give you various options to change font, font size, colour of the font etc. You can type text in the language of your choice provided that additional languages are added in Region and Language Settings of your Linux Distribution. You can refer QR Code to install Marathi Font.

![Text Tool Image]

Fig 7: Text Tool

BalBharatiDev01 font can be downloaded from ebalbharati site (if required)

Step 5: After you are satisfied with the font, size and other attribute, press escape. Note that a new layer is created with the text you entered. As you add various objects like text, graphics, drawings etc to your image, new layers are created. This enables you to selectively move the objects and change their colour, size etc. Later you can merge down these layers into your main image.

Step 6: Using move tool, we can move the text roughly to the centre of the image but instead we prefer to put it precisely in the centre, using the Align Tool. Click on Align Tool (short cut Q) and then select the Text layer and text. In the Align dialog, Select relative to image and click on Vertical Centre and then Horizontal Centre buttons. The text layer should now occupy the exact centre of the image.

Step 7: Drawing coloured oval (Ellipse): Change the background and foreground colours again with two different colours. We have chosen Red and Yellow respectively.

Create a new layer in your image. Now click on the Ellipse select tool (short cut E) and select the oval shaped area on the image. It will not have any colour. Use the menu Edit->'Fill with FG colour' to give Red colour to your oval. Similarly draw another one and fill with BG color.

Step 8: Using move tool place these ovals near the Text. Do not move them too far from the center or they will go to the rear side of the balloon. Select the layers one by one and merge them using the command Layer->Merge Down. We now have a colourful single layer. Let us create a balloon from this canvas.
Step 9: Do Filters->Map->Map Object. Select Map to Sphere, Check 'Update preview live' and Uncheck the 'Transparent Background'. This will give you a dialog showing the preview of the resulting balloon (sphere).

Press Ok and the image will now turn into nice balloon with 3D effect.

The balloon is little elongated since our canvas was rectangular.
**Step 10:** We will tweak the balloon further and give it more realistic shape. Apply the Distort Filter with Curve Bend option. That is Filter-&gt;Distort-&gt; Curve Bend. In the resulting dialog choose Automatic preview and Lower curve border. Then drag the Mid point of the Curve Indicator line using the mouse:

![Fig 11: Curve Bend filter Option](image)

Press Ok and you will get a nice colourful balloon with 3D effect.

![Fig 12: Output for Step 10](image)

**Step 11:** Let us remove the unwanted portion around the balloon. To do this simply do Image-&gt; Crop to content.
Step 12: Finally export the image to PNG (jpg format does not support transparency)
You can use this balloon as the object to other images. Open an image where you want to insert the balloon.

Fig 13: Output after cropping

Fig 14: Image for Step 12
File -> Open -> Image -> As Layer. Then move the balloon layer to the desired location and merge the balloon layer to the original image. Note that the transparent part is not visible. All images are rectangular in shape. Due to transparency our image appears to have balloon like shape.
Inkscape

Inkscape is a free and open source software for creating vector images. Vector Images are stored as drawing rules and not as a set of pixels. Whenever we resize a vector image, the image is redrawn using the rules. Hence the resized images have the same quality as that of original images.

The image rules or descriptions are stored in xml format with the extension SVG (Scalable Vector Graphics). Inkscape is primarily used for diagrams, charts, graphs, illustrations, logos, icons, line arts, user interfaces of softwares etc.

Inkscape is available on all major desktop operating systems. It is included in official repositories of all major Linux distributions. One can easily install it from package manager like Synaptic.

---

![Inkscape Opening Screen](image)

**Fig 16 : Inkscape Opening Screen**
The opening screen gives you a toolbar on the left. On the top you have a tool control bar. When a tool is selected, this bar shows various settings for the currently selected tool. The right side is reserved for additional dialogs such as fill and stroke align and distribute etc.

We will draw simple objects in order to learn basic skills using the given tools. We use only geometric shapes such as line, circle, ellipse, rectangle and square for these drawings. You might already have used similar tools in many other drawing and painting softwares. But Inkscape gives you far better control than most of the other softwares.

**Circle/Ellipse Tool:**

Let us start with Circle or Ellipse tool.

1) Select the tool button from left tool bar showing circle icon.

2) Drag it with the mouse to any place in the client area. You will get a circle or an ellipse from starting point to the end point where you release the mouse button. To get the exact circle, press the Ctrl key while dragging. This will guide you by snapping to the exact square.

3) After the ellipse is complete choose the selection tool (topmost from the left tool bar). Then click on the ellipse. The ellipse will then show 8 size handles. You can resize the ellipse by dragging these handles. Also clicking once again on it will turn the sizing handles to rotation handles. You can toggle between Size and Rotation handles.

**Fill Colour in the object:**

To fill the ellipse with colour, just click on any desired colour given in the bottom colour palette.

To choose more precise and accurate colours, use the menu Object \(\rightarrow\) Fill and Stroke. This will give a dialog with a few tabs and also Red, Green and Blue (RGB) colour options. You can choose any combination of Red, Green and Blue to obtain very precise colour from it. Note that you have 0 to 255 that is total 256 choices for each of Red, Green and Blue so total \(256 \times 256 \times 256 = 16777216\) colours can be chosen.
**Duplicate the object:**

Using duplicate, you will get an exact copy of the object. Using Edit→Duplicate (Shortcut Ctrl-d) you get exact copy of the same object. The duplicate will be at the same place so you need to move it in order to make the duplicate object visible.

**Activity:**

Draw different sized ellipses, fill them with colour, rotate and then move and position them in order to draw a simple object as shown below. Our example object is an animal made up of ellipses. A squirrel is shown using only ellipse. We have applied duplication of objects, colouring, rotation and order of objects at appropriate places. You can draw any other animal using simple objects.

Objects may overlap each other. This order of Objects can be changed by using menu Object -> Raise to Top, Lower to Bottom.

To draw line segments, use Bezier tool. After selecting the tool, click at starting point and drag with mouse to draw line, double click to finish the segment at desired point. Now to increase the line width, click on menu Object -> ‘Fill and Stroke’, while the line segment is selected. In the ‘Stroke Style’ tab, adjust the width.

To change the stroke paint, go to stroke paint tab in the same dialog and choose the desired colour. You may have to press shift at the time you click on colour in order to apply it. To draw a vertical or horizontal segment with precision, keep Ctrl key pressed during the drawing. This will correct the angle in steps of 15 deg as you move closer to the angle.

Using the node tool, transform the drawn segment into a curve. Select the tool and stretch (drag) the middle part of the segment. It will turn into a curve.

Let us fill this curve with a colour. It is very simple. Just select the object (curve in our case). Ensure that 8 sizing handles are surrounded by the object. Then click on the required colour. We have chosen Green colour. This will fill the region under the curve.

Now we draw a circle or ellipse. You are already familiar with this. Pick this tool from the left tool box and drag it on the canvas with left mouse button. Release the mouse button after you get the desired size of the ellipse. To produce exact circle, keep the ctrl button pressed. In the same way, rectangles or squares are drawn. We also draw two small ovals and fill them with a suitable colour.
We will draw another curve by stretching the line segment downwards. Fill it with some colour and join these two curves. Bring together these shapes to form a simple basic human figure. You need to select and move them in order to put them at proper places. You can use Edit->Duplicate (Shortcut Ctrl+d) for pair of feet. Also use rotate handles to rotate the object. Sizing handles are converted to rotate handles on click and vice versa.

Here is another example. A small bird with colourful wings, tail, beak and legs. All the components are geometric shapes that are joined together. Legs and Wings can be drawn and duplicated.

The adjacent diagram shows the drawing components used to make bird.

**Gradient in Inkscape:**

Let us now learn another concept in colouring, the Gradient. Gradient is a gradual mixture of colours. Gradients are used to give special effects to paintings. Gradients look attractive. They often give a kind of depth to the shapes.

**Activity to draw a staircase:**

1) Draw a parallelogram using beziar tool. Ensure that the last node will coincide with the first. This will make the region closed.

2) Now choose a plane colour to fill this region. We have chosen red. Go to menu Object->Fill and Stroke. Ensure that the region is filled with proper colour and the Fill tab is selected.

3) Finally click on Gradient tab. The region is now filled with red gradient slowly fading towards the other end with white colour. This is the upper surface of a staircase step.

4) Duplicate this object and move a little down words to get the bottom surface.
5) Next draw another parallelogram of appropriate size for the front surface. Fill this surface with Green Gradient.

6) We do not require the rear surface. A small edge may be drawn instead to indicate the rear surface of the step block.

7) Join all components. Completed single staircase block is shown in the adjacent figure.

8) Finally take multiple copies of this block and make a staircase object.

Always ensure that the desired color is filled in the region of the object before selecting gradient tab.

When duplicate is created it will be placed just above the original object. Select and move it immediately from its place to avoid multiple copies one below the other. This will unnecessarily increase the size of the image.

Palette gives only the standard set of colours. You can use Fill and Stroke dialog and RGB model tab to adjust the colour with more accuracy. There are CMYK and other models to select the colour. Study of colour models is beyond the scope of this textbook. Students are encouraged to study this advance topic.

**Activity to draw a simple flower:**

1) Draw one elongated ellipse. This is a petal of our flower.

2) Fill with pink colour.

3) Click on it to get sizing handles. Again click it to get rotation handles. Look carefully at the center of the ellipse. There you will find the center of rotation. If you try to rotate this petal using the handle, it will rotate around this center. We will move this center to left corner. To do this just drag it with mouse.

4) Now duplicate the petal (Ctrl+D). This operation will also copy the new location
of the center. Now if you rotate the petal. It will move along its corner like needles of the clock.

5) Duplicate and move these petals successively to get complete round of petals resulting into a flower.

6) We can decorate the flower further by adding colourful center. Draw a circle. Fill it with a bright colour, say red. In the fill and stroke dialog, increase the stroke width in stroke style tab. Choose a different stroke paint, we have chosen yellow. Now move this circle to the center of the flower.

7) Finally, we attach a stem to our flower. There is a calligraphy tool. This tool a used to write stylish text. This is a kind of angled pen. As you change the direction of the stroke, the width of the stroke changes. Draw a smooth curved stroke as shown. Also draw two ellipses for leafs. Give green colour to these objects. Use duplicate the leaf and use flap command to avoid repetitive work.

8) The completed flower is shown in the adjacent picture. Gradients can also be used to colour the petals. You can see in another example, the petals are coloured with yellow and orange color gradients. Try to draw different flowers and find out more tools that can be used for creating flowers.

Activity to draw Star and Polygon:

The next tool that we are going to try is Star and Polygon tool.

1) Open this tool. You can switch between star and polygon by the buttons given in this tool’s settings.

2) Drag Stars or Polygons of various sizes. One fascinating thing about star tool is that the underlined algorithm can produce different design patterns as you change basic parameters which create the star. Try experimenting on number of corners, spoke ratio and rounded setting.
Activity to draw a Snail:

Just below the star tool, there is spiral tool which can be used to draw the spirals of all sizes and styles. You can set number of turns and also the other parameters. Let us use spiral object to draw an interesting object, a snail. The shell of a snail has spiral pattern.

1) Draw a spiral and increase the stroke width.
2) Draw ellipse for body of the snail and use appropriate tools for other parts.
3) Draw triangle as a tail, small circles as eyes, rectangle & filled circle as antenna of the snail.

Activity to draw a Car:

We will now take a look at the Simplify path command. This command gives smoothness to the curve. The edges or corners are removed and replaced by smooth curve. It is a recurring process, that is you can give the command Path -> Simplify (Shortcut Ctrl + L) repeatedly till you get the desired result.

As an activity, let us draw a simple car object using bezier segments.
1) Using Bezier tool, draw an outline of a car by using a series of segments. Close the outline by choosing the first node as last node.

2) Now select the car outline and press Ctrl+L (Shortcut for Path -> Simplify. Corner nodes will slowly turn into curves. You can stop when desired seamless shape is obtained. In case you go ahead and smooth it more than required, you can always press Ctrl+Z (undo)

3) After you get the outline in good proportion, colour the car.

4) Create two wheels (circles) with thick stroke.

5) Give appropriate fill and stroke colour.

6) You may draw some strips to represent street. You may need to order the object using Object -> Raise to Top, Lower to Bottom.

**Activity**: Move the mouse pointer on the toolbar and identify the tools. Make a list.
**Skill Set 5 - Digital Content Creation**

**SOP 1:** Use of Toolbox and editing an image using GIMP.
- Create an image by using Toolbox controls from GIMP.
- Insert the image in an already created image.

**SOP 2:** Use GIMP for the following.
- Create a new image
- Put your name using the text tool.
- Use various filters to make a logo of your name.
- Autocrop image to text size.

**SOP 3:** Use Inkscape for the following.
- Draw a simple landscape using basic geometric shapes.
- Use gradient tool for the same.

**SOP 4:** Use Inkscape for the following.
- Load an 1d size image,
- Make 12 copies of it.
- Arrange in 4 rows x 3 columns on an A4 size page.

**SOP 5:** Use Inkscape for the following.
You are starting a new business.
- Create an advertisement to be published in local newspaper promoting your product or services.
- Size should be 210 x 210 mm.
- Create your own visiting card using inkscape.

**SOP 6:** Using Inkscape make the following picture.
Create a database in PostgreSQL

To create a database in PostgreSQL, the `create database` statement is used.

**Syntax:**
```
postgres=# create database database_name;
```

**Example:**
```
Postgres> create database college;
```

To view databases:

To view a database, the `\l` command is used.
```
postgres=# \l
```

<table>
<thead>
<tr>
<th>Name</th>
<th>Owner</th>
<th>Encoding</th>
<th>Collate</th>
<th>Ctype</th>
<th>Access privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>balbharti</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_IN</td>
<td>en_IN</td>
<td></td>
</tr>
<tr>
<td>college</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_IN</td>
<td>en_IN</td>
<td></td>
</tr>
<tr>
<td>postgres</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_IN</td>
<td>en_IN</td>
<td></td>
</tr>
<tr>
<td>template0</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_IN</td>
<td>en_IN</td>
<td>=c/postgres</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>postgres=CTc/postgres</td>
</tr>
<tr>
<td>template1</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_IN</td>
<td>en_IN</td>
<td>=c/postgres</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>postgres=CTc/postgres</td>
</tr>
</tbody>
</table>

(5 rows)

To connect database:

To connect to a database, the `\c` command is used.
```
postgres=# \c database_name
```

**Example:**
```
\c college;
```

You are now connected to database "college" as user "postgres".

`college=#`
To create table:

To create table in database **Create table** command is used.

```
databasename = # create table table_name (fieldname Datatype, fieldname Datatype);
```

```
college=# CREATE TABLE XI (Roll_no integer, Student_name text);
college=#
```

To insert data in table:

To insert data in a table **insert into** command is used.

```
databasename=# insert into table_name (field name)values(data1,'data1')
college=# INSERT INTO XI (Roll_no,Student_name) VALUES(101,'Sachin');
college=#
```

To view inserted data:

To view inserted data **select** * from command is used.

```
database name=#select * from table_name.
college=# SELECT * FROM XI;
    roll_no | student_name
-------------+-------------
      101 | Sachin
(1 row)
```

To update table:

To update table **UPDATE** command is used.

```
databasename=#update table_name SET column_name=Value WHERE Reference_Column_name=Value
```

```
college=# UPDATE XI SET Roll_no = '1001' WHERE Student_name = 'Sachin';
college=#
```
To add Primary Key:

To add primary key to already created table, we can use following command.
or we can create primary key during table creation.

```
ALTER TABLE table_name ADD PRIMARY KEY (column_name);
```

To add Foreign Key:

To add foreign key while creating table, we can use the following command or
we can create foreign key during table creation.

```
ALTER TABLE table_name ADD FOREIGN KEY (current_column_name)
REFERENCES refered_table_name (referedtable_primarycolumn_name);
```

One to One relationship

```
college=# CREATE TABLE Marks (roll_no integer PRIMARY KEY, total_marks integer,result
text,record_no integer,FOREIGN KEY (roll_no) REFERENCES XI(Roll_no));
CREATE TABLE
```

Let's see the result of both table 'XI' and 'Marks' with one-to-one relationship.

```
college=# SELECT XI.Roll_no,XI.student_name,Marks.total_marks,Marks.result FROM XI,Marks where
XI.Roll_no=Marks.roll_no;
<table>
<thead>
<tr>
<th>roll_no</th>
<th>student_name</th>
<th>total_marks</th>
<th>result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Sachin</td>
<td>230</td>
<td>PASS</td>
</tr>
</tbody>
</table>
(1 row)
```

Do you know ?

- \c Connect to database
- \l List all the databases
- \dt List all the tables from database
- \d To view view structure of table.
To delete table:
To delete table, DROP command is used.

```
database=# DROP table_name;
```

```
postgres=# DROP TABLE Marks;
DROP TABLE
```

To delete database:
Drop command is used to delete database also.

```
postgresql=# drop database database_name;
```

```
postgres=# DROP DATABASE college;
DROP DATABASE
```

**Note:** Before deleting the current database you have to connect to another database eg. postgresQL
SOP 1: Create a database, using PostgreSQL named hospital.

- In this database, create a table of patients with the following fields:
  Patient_ID, Patients_Name, Address, Room_number and Doctor's_name.

- Give appropriate data type for each field.

<table>
<thead>
<tr>
<th>Patient_ID</th>
<th>Patient_name</th>
<th>Address</th>
<th>Room_number</th>
<th>Doctor’s name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SOP 2: Create a database using PostgreSQL named School-master.

- In this database create a table of students with the following fields:
  student_ID, student_name, Address, Phone_number, Date_of_Birth.

- Give appropriate data type for each field. Enter at least 5 records.

SOP 3: Given the list of fields: EmpId, EmpName, EmpDepartment, SalaryId, SalaryAmount, Bonus in the tables Employee and Salary respectively. Define primary key, foreign key and segregate for above fields into employee and salary table. Also create one-to-one relationship between Employee and Salary Table.
APPENDIX

Steps For Installing Linux OS

Steps For Installing Libre Office

Steps For Installing PostgreSQL

Steps For Installing GNUKhata
Installing GNU/Linux (Ubuntu) - An Important Skill for Digital Literacy

We will now install Ubuntu 18.04. Installation skill is often required in everyday life as your computer sometimes gets formatted or your hard disk may crash. We will learn three different methods of creating an installer. Students are required to learn all of them.

1. Creating Installation DVD of GNU/Linux

GNU/Linux distribution comes as an ISO image file. An ISO image file is an image of a CD or DVD which is stored as a usual binary file on disk. From the respective Linux distributions website, download the installation ISO file (Image). We will download Ubuntu 18.04 desktop 64 bit ISO image from Ubuntu official website www.ubuntu.com.

The easiest way to make an installation DVD is to Right Click on the iso file from your file manager. Most probably your current OS would have image burning feature built-in. If it shows burn image options menu then you can insert blank DVD in the DVD drive and burn the image straight away.

If you are using an old operating system, you might have to use separate image burning software. Few free and open source DVD burners are Infra Recorder, cdrトte, DVD Flick, DVDStyler, Burn and also many more are available. Install one of these softwares and burn the Installation DVD.

You can also create a GNU/Linux Installation USB disk as given in the following paragraph which is the most preferred method.

Creating GNU/Linux Live USB Installer (Recommended Method)

Burning DVD from ISO is perhaps the simplest way to create GNU/Linux installer but there are certain disadvantages of this method. DVD has a short shelf life. If the disk has even a small read error it becomes useless. Active GNU/Linux distributions are updated regularly. Every few months, new improved versions keep coming with new features and security updates. Hence your installer DVD will become obsolete in a few months. Also, read/write speed of DVD is far less than USB. Hence it will take a long time to install. On the other hand, USB is much faster if you want to run GNU/Linux live session without installation. The Read Only DVD is wasted in case of any error during the writing process. But USB disk can be formatted and reused once the installation is finished. Thus USB can reduce e-waste to some extent.
Creating Live installation USB is also easy. Let us learn this skill now. We assume that you have Ubuntu 18.04 ISO file stored in your disk. The method is the same for all other distributions. You can very well install them with this method.

There are a many free and open source tools that can be used to create such USB installer disk. We will show here two such tools namely **Rufus** and **Etcher**. We will also show how to use one of the advance **disk duplicator** tool **dd**. Do try other tools, if you like, and compare them with the tools given here.

1. **Rufus**: Rufus (Pronounced as ROO-Fuss) has General Public License (GPL). It means that you are free to distribute and even modify Rufus software to suit your needs. The source code is available in public repositories.

   The advantage of Rufus is that it is very small in size (about 1 mb). Also Rufus is a portable software. It means that you can Rufus from the executable file without installing it. So go and download Rufus from its website. Plug the usb disk (at least 4 GB). Start Rufus by double-clicking on the downloaded file. In the device menu, you can see your USB name. In boot selection menu select the downloaded ISO file. Most of the other entries will be filled automatically once you load the iso file. Accept these defaults and click on the start button. You may be asked permission to download system file syslinux. Click okay. In a newer version, this dialog may not appear.

   Next, you will be shown hybrid image dialog. Leave defaults and click on okay. In rare cases, if the hybrid image method does not work, you have the option of dd image method. We will also learn this method separately in the last section.

   Finally, you will be warned that all the data on the disk will be destroyed. If you have not already taken the backup of the data on the disk, you can cancel the process and copy the data from the disk to a safe place. Otherwise, the press continues to start the process. It will take about 3 to 8 minutes depending upon the read/write speed of your USB disk. The indicator will tell you the progress status. Once the process is over the ready message will appear. You can now close the application and eject your USB disk. Using this Live USB, you can install Ubuntu 18.04 LTS on any desktop or laptop.

![Refus USB creator](image-url)
2. **Etcher**: Etcher is a cross-platform free and open source utility distributed under Apache license. Etcher is very easy to use. To download etcher, first, plug in your USB drive. Then start Etcher.

Now there are only three natural steps needed to make boot-able pen drive:

1) **Select Image**
2) **Select Drive**
3) **Flash**

In the first step select downloaded iso image from the disk. In the next step, select this as your target USB drive (if it is not selected by default).

In the last step, select flash to start the process. Once the process is over your USB disk is ready as Linux Installer.

![Etcher USB creator](image)

3. **dd Command (Quick Advanced Method)**: Our last utility “dd command” is an advanced method which is applicable only for GNU/Linux distributions. This method is useful if you have already installed Linux on one of the machines and you would like to create USB installer. The advantage of dd command is that it is a one-line command. With just one line, the USB installer is created. Moreover, the command is always available in all GNU/Linux distribution. dd Stands for Data Duplicator. It is an internal command for all GNU/Linux distributions.

**Please use dd command with care, preferably under the guidance of your teacher or you may accidentally format the hard disk of your computer.**

**Step 1**: First, go to the terminal by using terminal menu or press **Ctrl + Alt + T**. (The shortcut may be different). Plug in your USB disk.

**Step 2**: Find out the drive letter by giving the **$lsblk** command.

Most probably sda will be the letter for hard disk and sdb will be your USB drive letter. Confirm again by carefully examining the output. Ignore the partition letters, if any, like sda1, sda2, sdb1 etc. The volume label will confirm your drive letter and also the size. It will be little less than 4 GB for a 4 GB disk. (3.7 G in the adjacent picture).

**Step 3**: Once you confirm the drive letter you can go and give the dd command. It is assumed that you have kept the ISO image in the default home folder where the terminal is opened by default.
Step 4: Make USB boot-able using dd command
$sudo
dds=4M\ if=\ "Ubuntu\ 18.04.iso"\ of=/dev/sdb\ status=progress
Enter the Admin password when asked. The terminal will show process indicator in percentage (as shown in fig 3).

![lsblk output](image)

Fig. 3: Output of 'lsblk' command

Step 5: Once this process is over, do not be in a hurry to take out USB. You must flush the output buffer by the command

$sync:

That’s it. Wait for sync to finish. Your USB GNU/Linux installer is ready.

Installing GNU/Linux (Ubuntu)

The first step before installing Ubuntu is taking a backup. Copy all the important file to an external hard drive. Make sure to not miss any files. Installing GNU/Linux involves formatting your hard drive. This means all the data on the hard drive will be deleted. You can copy the files back once you have installed GNU/Linux.

Once the backup is done, remove your backup drive, and insert your Installation USB/DVD that you created in the previous section. Now restart your computer. In order to start the installation, you need to access the boot menu/BIOS/UEFI. This is different on every computer. Steps for various vendors are given below.

Generally, you can press the [DEL] key, [F2] key, [F10] key, or the [F12] key while the computer is turning on. This has to be done right after you press the power button. Look up for the correct method to do this for your computer.

You should now be on a blue background menu. Use the keyboard to navigate. You need to make sure of the following things:

- Secure Boot is disabled
- Boot Mode is Legacy/BIOS and not UEFI
- Your installation DVD/USB has the highest boot priority.

Once that is done, choose the save and reboot option. You should now be in the Ubuntu Installer (as shown in fig. 4). Choose “Try before installing” using the keyboard and press Enter.
Once your desktop loads, you can explore the system. To start the installation, double-click on the “Install Ubuntu 18.04” icon on the desktop. It will ask what language and keyboard layout you have (as shown in Fig. 5). Keep those as default. You can choose “English – India” if you want the (Rupee) symbol, among other things.

Next, it will ask if you want to connect to WiFi. Click on “I don’t want to connect to WiFi right now.” If you connect to WiFi you can choose to download updates from the internet while installing, but that significantly increases the installation time. Click on next.

The next menu is “Updates and other software” (as shown in Fig. 5). Check the “Install third party software” box. This will allow you to view movie DVDs, etc. Un-check the “Download updates while installing Ubuntu”. You can install updates after you have installed Ubuntu.
Also, choose “Normal installation”. This will take more space, but includes a large amount of software. Again, click on next.
Now, click “Erase disk and install Ubuntu” and click on “Install now” (as shown in fig. 7).

**Fig. 6 : Ubuntu Installation Updates**

Ubuntu will give you a Summary of the changes it is going to make. Click on “Write change the disk” to confirm (as shown in fig. 8).

**Fig. 7 : Ubuntu Installation Types**
Before installing, Ubuntu will ask for your user information. First is your timezone. In India, the IST (Indian Standard Time) is used. The (as shown in fig. 9) city for IST is Kolkata.

Choose that and click on next, then input your Name, Computer name, Username, and Password. And finally, click on “Install now.” (as shown in fig. 10)
The installation will take 30 min to 1 hour.

After its done, Ubuntu will ask you if you want to restart your computer. Click on “Restart now”, and remove the DVD/USB when it will you to do so. You should now have Ubuntu installed on your computer.

Fig. 10: Ubuntu user profile creation

Fig. 11: Ubuntu installation complete screen
You can install Libre Office suite from its official website for free of cost:
http://www.libreoffice.org

It is available for various operating systems.

For GNU/Linux Operating System:

As a general rule, you are advised to install LibreOffice via the installation methods recommended by your particular Linux distribution (such as the Ubuntu Software Center, in the case of Ubuntu Linux). This is because it is usually the simplest way to obtain an installation that is optimally integrated into your system. Indeed, LibreOffice may already be installed by default with your Linux operating system.

In short, you will be able to download LibreOffice packages tailored to your system's packaging standard (RPM or deb), or even get a .tar.gz archive for LibreOffice. You will then need to install these packages, first the main LibreOffice binaries, then the additional components such as language packs and built-in help.

Just follow the instructions provided by the wizard and install Libreoffice.

For Windows Operating System:

Download

If you are unsure which Windows version you have, press Win+Pause to open your system properties window. The LibreOffice Main Installer download page can be selected with a built-in help file for your language:

- Click here for the 32-bit version.
- Click here for the 64-bit version.

Click the green button with white writing which says “DOWNLOAD VERSION”. If the download does not automatically begin, click ‘Save File’. You are invited to give an optional donation.

Install

Open the folder where the Main Installer has been downloaded and double-click on the Installer.

Welcome

The Installation Wizard Welcome dialog box opens it and advises that the installation process is about to be started. Click on “Next >”
Setup Type

Another dialog box opens, giving you a choice whether you want a default installation, or whether you want to choose special locations and components. If you want a default installation, just press “Next >”. If you want to make special choices, click on “Custom” and then press “Next >”.

Custom Setup

The Custom Setup enables changes to the features that will be installed.

If you would like to install the spelling dictionaries, hyphenation rules, thesauri and grammar checkers:

- Click Optional Components
- Click Dictionaries

Once all required changes to the features have been completed, click on “Next >”

File Type

Another dialog box opens, inviting you to choose whether to open Microsoft Office documents with LibreOffice. By default, this feature is not enabled. If you want LibreOffice to open Microsoft Office files (documents, spreadsheets and presentations), put a checkmark in all four checkboxes. Click on “Next >”

Shortcut and Load during system startup

Another dialog box opens, asking you whether:

- A shortcut to open Libre Office should be placed on your desktop. The default option is to create a shortcut.
- To load LibreOffice during system start-up.

After your selection press “Install”.

LibreOffice is Installing

If the User Account Control dialog shows, click on “Yes” to continue the installation.

LibreOffice Installation Completed

Click “Finish”.
Step For Installing PostgreSQL

1) Open terminal using keys Ctrl+Alt+T

2) Type following command to update your system

```
sudo apt-get update
```

(Here you will be prompted for password, Enter the password which you used to login this system) You will get output similar to Fig 1 below.

![Fig 1: Update your Source list on Ubuntu](image)

3) Type following command to PostgreSQL

```
sudo apt-get install postgresql postgresql-contrib
```

You can see the output similar to Fig 2 as shown below and it will prompt you to continue or not. Type ‘y’ and hit Enter.

![Fig 2: Process to install PostgreSQL](image)
Once successfully installed, you can use default postgresql user account called ‘postgres’. So to switch over to the postgres account, on your server terminal type:

```
sudo -i -u postgres
```

Now to use PostgreSQL type on terminal:

```
psql
```

You can see output similar to Fig 3.

**Fig 3: PostgreSQL shell**
1) Go to https://gnukhata.in/ and click on download software. Register and download Offline installer for Ubuntu. (Eg. GNUKhataOfflineInstaller_For_GNULinux_v6.0.tar.gz or latest version)

2) Extract the GNUKhata Offline version and double click on ‘Installer’.

3) Read and accept terms and condition
4) Enter password.

5) Installation process will continue. Once installed is completed, Open browser and type http://localhost, following screen will appear which indicates successful installation of GNUKhata.
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT -</td>
<td>Information Technology</td>
</tr>
<tr>
<td>ICT -</td>
<td>Information and Communication Technology</td>
</tr>
<tr>
<td>CPU -</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>MICR -</td>
<td>Magnetic Ink Character Recognition</td>
</tr>
<tr>
<td>OCR -</td>
<td>Optical Character Recognition</td>
</tr>
<tr>
<td>RAM -</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>ROM -</td>
<td>Read Only Memory</td>
</tr>
<tr>
<td>DOS -</td>
<td>Disk Operationg System</td>
</tr>
<tr>
<td>GUI -</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>CLI -</td>
<td>Command Line Interface</td>
</tr>
<tr>
<td>LAN -</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>MAN -</td>
<td>Metropolitan Area Network</td>
</tr>
<tr>
<td>WAN -</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>GNU -</td>
<td>GNU's Not UNIX</td>
</tr>
<tr>
<td>ARPANET -</td>
<td>Advance Research Projects Agency Network</td>
</tr>
<tr>
<td>ATM -</td>
<td>Automated Teller Machine</td>
</tr>
<tr>
<td>GIMP -</td>
<td>GNU Image Manipulation Program</td>
</tr>
<tr>
<td>FHS -</td>
<td>File System Hierarchy Standard</td>
</tr>
<tr>
<td>DVD -</td>
<td>Digital Versatile Disc</td>
</tr>
<tr>
<td>CD -</td>
<td>Compact Disc</td>
</tr>
<tr>
<td>ALU -</td>
<td>Arithmetic Logic Unit</td>
</tr>
<tr>
<td>MMU -</td>
<td>Memory Management Unit</td>
</tr>
<tr>
<td>CU -</td>
<td>Control Unit</td>
</tr>
<tr>
<td>SSD -</td>
<td>Solid State Drive</td>
</tr>
<tr>
<td>HDD -</td>
<td>Hard Disc Drive</td>
</tr>
<tr>
<td>TCP/IP -</td>
<td>Transmission Control Protocol / Internet Protocol</td>
</tr>
<tr>
<td>DNS -</td>
<td>Domain Name System</td>
</tr>
<tr>
<td>DHCP -</td>
<td>Dynamic Host Configuration Protocol</td>
</tr>
<tr>
<td>FTP -</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>HTTP -</td>
<td>Hypertext Transfer Protocol</td>
</tr>
<tr>
<td>IMAP -</td>
<td>Internet Message Access Protocol</td>
</tr>
<tr>
<td>IS -</td>
<td>Information System</td>
</tr>
<tr>
<td>iOS -</td>
<td>iPhone Operating System</td>
</tr>
<tr>
<td>IRC -</td>
<td>Internet Relay Chat</td>
</tr>
<tr>
<td>ITES -</td>
<td>Information Technology Enabled Services</td>
</tr>
<tr>
<td>POP3 -</td>
<td>Post Office Protocol Version 3</td>
</tr>
<tr>
<td>SMTP -</td>
<td>Simple Mail Transfer Protocol</td>
</tr>
<tr>
<td>DSL -</td>
<td>Digital Subscriber Line</td>
</tr>
<tr>
<td>USB -</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>WEP -</td>
<td>Wired Equivalent Privacy</td>
</tr>
<tr>
<td>Wi-Fi -</td>
<td>Wireless Fidelity</td>
</tr>
<tr>
<td>OTP -</td>
<td>One Time Password</td>
</tr>
<tr>
<td>CVV -</td>
<td>Card Verification Value</td>
</tr>
<tr>
<td>WWW -</td>
<td>World Wide Web</td>
</tr>
<tr>
<td>IIS -</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>URL -</td>
<td>Uniform Resource Locator</td>
</tr>
<tr>
<td>PNG -</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>DBMS -</td>
<td>Database Management System</td>
</tr>
<tr>
<td>RDBMS -</td>
<td>Relational Database Management System.</td>
</tr>
<tr>
<td>SQL -</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>ISO -</td>
<td>International Organization For Standardization</td>
</tr>
<tr>
<td>DDL -</td>
<td>Data Definition Language</td>
</tr>
<tr>
<td>DML -</td>
<td>Data Manipulation Language</td>
</tr>
</tbody>
</table>
Minimum Hardware requirement for Ubuntu 18.04

- 2 GHz dual-core processor
- 2 GB RAM (Recommended: 4 GB RAM)
- 25 GB of hard-drive space (or USB stick, memory card or external drive but see LiveCD for an alternative approach)

Software Recommendations

- Libre Office - Libre Office 6.0 or higher. (Use 64-bit Windows OS with SP1)
- PostgreSQL - PostgreSQL 9.5 or higher.
  
  Note: We can use GUI tool for PostgreSQL called pgAdmin with version 1.18.1 or higher
- GNUKhata - 6.0 or higher.
- GIMP - GIMP 2.8 or higher.
- Inkscape - Inkscape 0.92 or higher.
The Constitution of India
Chapter IV A

Fundamental Duties

ARTICLE 51A
Fundamental Duties- It shall be the duty of every citizen of India–
(a) to abide by the Constitution and respect its ideals and institutions, the National Flag and the National Anthem;
(b) to cherish and follow the noble ideals which inspired our national struggle for freedom;
(c) to uphold and protect the sovereignty, unity and integrity of India;
(d) to defend the country and render national service when called upon to do so;
(e) to promote harmony and the spirit of common brotherhood amongst all the people of India transcending religious, linguistic and regional or sectional diversities, to renounce practices derogatory to the dignity of women;
(f) to value and preserve the rich heritage of our composite culture;
(g) to protect and improve the natural environment including forests, lakes, rivers and wildlife and to have compassion for living creatures;
(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;
(i) to safeguard public property and to abjure violence;
(j) to strive towards excellence in all spheres of individual and collective activity so that the nation constantly rises to higher levels of endeavour and achievement;
(k) who is a parent or guardian to provide opportunities for education to his child or, as the case may be, ward between the age of six and fourteen years.

Practical Notebook for Standard XI
Practical Notebook Cum Journal

- Based on Government approved syllabus and textbook
- Inclusion of all practicals as per Evaluation scheme.
- Inclusion of various activities and objective questions
- Inclusion of useful questions for oral examination
- Separate space for writing answers

Price:
- Physics Practical Notebook Standard XI: ₹ 63.00
- Chemistry Practical Notebook Standard XI: ₹ 59.00
- Biology Practical Notebook Standard XI: ₹ 74.00

Practical notebooks are available for sale in the regional depots of the Textbook Bureau.

1. Maharashtra State Textbook Stores and Distribution Centre, Senapati Bapat Marg, Pune 411004
2. Maharashtra State Textbook Stores and Distribution Centre, P-41, Industrial Estate, Mumbai - Bengaluru Highway, Opposite Saakal Office, Kolhapur 416122
3. Maharashtra State Textbook Stores and Distribution Centre, 10, Udyognagar, S. V. Road, Goregaon (West), Mumbai 400062
4. Maharashtra State Textbook Stores and Distribution Centre, CIDCO, Plot no. 14, W-Sector 12, Wagha Road, New Panvel, Dist. Raigad, Mumbai 410206
5. Maharashtra State Textbook Stores and Distribution Centre, Near Lekhanagar, Plot no. 24, MAGF Sector, CIDCO, New Mumbai-Agra Road, Nashik 422009
6. Maharashtra State Textbook Stores and Distribution Centre, Opposite Rabindranath Tagore Science College, Mahanag Bang Road, Nagpur 440001
7. Maharashtra State Textbook Stores and Distribution Centre, Near Railway Station, Aurangabad 431001
8. Maharashtra State Textbook Stores and Distribution Centre, Opposite Rabindranath Tagore Science College, Mahanag Bang Road, Nagpur 440001

E-learning material (Audio-Visual) for Standards One to Twelve is available through Balbharti...
- Register your demand by scanning the Q.R. Code given alongside.
- Register your demand for E-learning material by using Google play store and downloading eBalbharti app.

www.ebalbharti.in, www.balbharti.in